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What is Theophilos? 

Theophilos is fast and effective way to explore God's word. It comes packed with powerful 
features that you wouldn’t expect to find in a free program. The fact that Theophilos is free 
»Page 14 should in no way mean that "you get what you paid for". In fact you are receiving a 
package of great value which can grow even more with many available add-ons »Page 96 
broadening its possibilities. 
 
The free package »Page 12 of Theophilos comes complete with the following: 
 
• Full version  of Theophilos Bible Software. No registration fees, no expiration reminder 
screens . This is not  a so called "Demo" or "Light" version either. 
• Full text of King James (Authorized) version  of the English Bible (including Old and New 
testaments) with Christ's words in red  
• Complete Matthew Henry's Concise Commentary  on the whole Bible 
• Complete Easton's Bible Dictionary 
• Preview of multimedia Bible narration  with pictures and sound 
• Greatest Bible Passages  jumplist 
• Sample of a topic book  to help you store your knowledge 
• Intro music  - excerpt from "And I Saw As It Were... Konelrad" by Kerry Livgren  from his 
album "One Of Several Possible Musiks". Copyright © 1989 Kerry Livgren Productions, Inc. 
Used by author's permission.  
 
 
What can you do with it?  
 
• Navigate the Bible 
• Do extensive research of the Bible 
• Compare more Bible versions 
• Search and consult dictionaries 
• Search and view notes and commentaries 
• Search and study early Christian writings 
• Display and search HTML documents 
• Create your own dictionaries or topic books to store your knowledge and studies 
• Create your own notes and commentaries 
• Create Jumplists™ for special handling of verse lists and bookmarks 
• Create custom modules using Scribe for Theophilos authoring tool and distribute them to 
other users of Theophilos 
• Search your own documents 
• Hear and watch multimedia Bible narrations or presentations of God's Word and create your 
own 
• Record audio notes and comments to every verse of the Bible 
• Attach sounds and pictures to Bible verses 
• Add your own pictures and sounds to menu for instant access 
• Use Theophilos in network environments 
• Copy or print everything through easy to use dialog 
• Change fonts in every window 
• Communicate with the program in several available languages or create the localization in 
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your own language by yourself 
• Customize program behavior and look with many options 
• If you are visually impaired and rely on screen reading software, experience an exceptional 
accessibility of Theophilos 
• If you are a publisher of textual and multimedia content you can license Theophilos to 
publish and distribute your own CD products 
• Give it freely to your friends... 
 
 
Yet there is more!  
 
For all advanced Bible students or simply all who want to study God’s word in greater depth 
we are offering many add-on modules on Theophilos Library CD »Page 96 . Or you can 
even be an author  yourself! We offer special authoring tool »Page 13  helping you to create 
and distribute your own add-on modules. You can think of these add-ons as books that you 
can add to your library one by one or several at a time. On the CD you can choose from Bible 
versions, dictionaries, commentaries, writings and other study materials that can be plugged 
into your copy of Theophilos along with narrations, illustrations, maps and music. Many add-
ons are available for free download at our web site »Page 98  or other web sites on the 
Internet. Our complete suite is available on CD which can be mailed to you anywhere in the 
world. Please read more about Theophilos Library CD »Page 96. 
 
 
 

Why should you use software like this one 

Software packages like Theophilos do not and do not intend to replace printed versions of the 
Bible or reference works. Printed copy of the Bible should always be the choice for your 
reading and devotion time. But there are many important advantages of Bible software over 
printed materials. Computer aided study is much more convenient , efficient , faster  and 
more effective . Not only do you have instant access to any verse of any version of the Bible 
but Theophilos makes searching for any word, group of words or phrase a snap. As a 
complete electronic concordance it makes sometimes hours of searching a matter of a 
second. A wide variety of reference materials  written by well-respected Bible scholars are 
just a mouse-click away. They don’t take up any space on your desk as would all the books 
that are available as add-on modules. Currently we are offering many modules  on our 
Theophilos Library CD »Page 96 . Many other modules are available for free download from 
Internet sites. You can also store all your knowledge in electronic form for further processing. 
You may even search all your writings in Theophilos. 
 
When you use Theophilos you will not only read but also hear the Word of God . Or you have 
the option of recording  your own audio notes or create impressive multimedia presentations 
of God's Word. With Theophilos Library CD »Page 96 you will experience the power of 
multimedia in Bible software 
 
Bible software today is a must for any Bible teacher and serious Bible student. We 
trust that you will find Theophilos to be one of the best tools available for this purpose. 
 
 

What is freeware? 

Freeware is any software that is offered to public by the author free of charge . While author 
retains any and all rights to his software he does not require his users to pay for its use. 
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In the light of the above definition Theophilos program is distributed as freeware. It requires 
no other software or add-ons to function to its fullest without any limitations. There are no 
hidden costs  or purchase requirements. Freeware version is the only available version of 
Theophilos program. It is not a demo, trial, light or in any way limited version.  
 
Note: 
Additional add-ons are offered as enhancements and are not required for correct and full 
function of Theophilos program. However for some students of God’s Word they may be a 
welcome extension of Theophilos’ capabilities in the form of indispensable source of 
reference. You can choose from Bible versions, dictionaries, commentaries, writings and 
other study materials that can be plugged into your copy of Theophilos. Many add-ons are 
available for free download at our web site »Page 98  or other web sites on the Internet. 
Our complete suite is available on Theophilos Library CD »Page 96  which can be mailed to 
you anywhere in the world. 
 
While Theophilos is free for the user, if you are a publisher and wish to distribute Theophilos 
with your own CD product you need to license Theophilos for such use. 
 
See also Warranty and license agreement »Page 15, Theophilos advantage »Page 27, 
Publishing and distributing your own CD products »Page 28 
 
 

What are add-ons? 

The idea behind the add-ons is simply to offer a wide array of extensions  to the basic free 
package »Page 11 so that all users may choose whatever reference tools they need in their 
study of God's Word and integrate them easily in one common user interface. We even offer 
a special authoring tool »Page 13 so you can create add-ons yourself and offer them to 
public. You can choose from many modules: Bible versions, dictionaries, commentaries, 
writings and other study materials that can be plugged into your copy of Theophilos. Many 
add-ons are available for free download at our web site »Page 98  or other web sites on 
the Internet. Our complete suite is available on Theophilos Library CD »Page 96  which can 
be mailed to you anywhere in the world. 
 
 
See also Theophilos Library CD »Page 96, ordering information »Page 93, installing add-on 
modules »Page 89, making own add-ons »Page 13 
 
 
 

Authoring tool for Theophilos 

With Theophilos you have an effective tool for your studies of God's Word with features 
allowing you to collect , record  and retrieve your knowledge. However you may also wish to 
publish and distribute this knowledge to other people so that they may benefit from your 
studies. Considering that Theophilos Bible Software is being used by many thousands  of 
people today it is a solid platform  for sharing your work. For this reason we have created 
SCRIBE FOR THEOPHILOS  an ideal companion to our Bible software. 
 
Theophilos is an open system Bible software which means that you can add new text 
modules to enhance your study experience or take advantage of our easy licensing policy and 
become a publisher of your own CD-ROM products »Page 28 based on Theophilos reader 
engine. Until the release of Scribe for Theophilos most modules could be obtained only from 
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us on CD. This tool has radically changed  this situation since with it everybody including 
you  can produce add-on modules for Theophilos and distribute them over Internet or by any 
other means. In addition to your own texts that you would like to share or distribute there are 
multitudes of texts in public domain*. You may find these texts in electronic form on Internet, 
bulletin boards and other sources. Once you have the text you are ready to create the add-on 
module. With these new possibilities we think that Scribe for Theophilos is an ideal 
companion to our Bible software and a must have for every scholar, missionary, pastor, Bible 
teacher or serious Bible student. 
 
Just imagine:  
 
• easily create  any type of Theophilos add-on module** virtualy from any text 
• use  it for your own studies immediately taking advantage of Theophilos‘ embeded 
capabilities of linking text, text searching or recognition of verse references 
• create richly formatted documents with hyperlinks , colored text  and more 
• convert  your personal studies to Theophilos' topic books and note sets and continue to add 
more of your insight to them 
• exchange  modules with your friends and study companions for their enjoyment 
• publish  your own texts in Theophilos‘ format for many thousands of users of our Bible 
software over Internet, BBS or other distribution means 
• as a pastor or Bible teacher distribute  your sermons, lessons and commentaries to your 
congregation 
• if you are interested in copy-protecting  your distributed work you can lock your modules 
and add other protective features to your documents with the Professional version of Scribe 
• you may even take part in our project  and add modules that you create to our CD so all 
users of Theophilos Library CD may benefit from them. Of course we will acknowledge you as 
the author of the module with your name appearing in documentation. 
 
 
As you can see, the possibilities are endless. Please visit our Internet pages »Page 98 for 
free download of evaluation copy of Scribe for Theophilos  and become an author today. 
 
 
* copyrights have expired to these texts so they may be freely used and distributed 
** this does not include Bible version modules 
 
 

Why do we offer Theophilos for free 

We believe that salvation of God is free  for everyone who accepts it and we wish to use this 
principle to pass His Word to all - believers and non-believers alike. While we retain all rights 
to Theophilos, we do not charge anything for its use. Also, we DO NOT ask for any financial 
gifts or contributions of any kind. We hope that by offering Theophilos for free to all users we 
may participate in spreading God’s Good News throughout the world. 
 
After all you are not obliged in any way to use Theophilos Bible Software. We challenge you  
to try other software packages and choose the one you like the best. Or don’t use any at all. 
Just keep on reading, studying and praying for understanding. This copy of Theophilos is 
our gift to you . We hope you will enjoy it and use it for the Glory of God. 
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The third release 

 
This is the third release of Theophilos Bible Software. Previous versions of Theophilos were 
very successful  and the program has gained many thousands of users worldwide . We 
want to thank to all who have written to us and have been great encouragement in our further 
development of this software. We have been inspired by many letters and e-mails and tried to 
fulfill most of our users’ requests. To them we even added our own ideas that, as we believe, 
will become popular features not found in other software packages  freeware, shareware 
or commercial. Many of them are truly unique only to Theophilos . 
 
We did everything we could think of to make it the most usable software of its kind on the 
market. The reason why it is so important to us is very simple. Not only did we design, 
program and thoroughly test the product but we also use it ourselves  in our personal studies 
of God's Word.  
 
Although our target user is not a professional Bible scholar fluent in Hebrew and ancient 
Greek, we believe that many pastors, teachers and students will benefit from Theophilos and 
will find it worthy of recommendation to others. We designed Theophilos for all who wish to 
come to deeper understanding and are commited to dilligent study of God‘s Word.  
The freeware package may even be distributed as part of your evangelization project – 
royalty free! *  
 
With Theophilos you have a complete multimedia Bible study suite  that has many unique 
and advanced features, yet remains simple to operate. 
 
We know that perfect software that suits all users does not exist. Therefore we urge you , the 
user, not to hesitate and tell us what you think . It is very important, since future 
developments »Page 15 will be made with your suggestions in mind.  Together we may 
build a Bible study tool that will come as close to perfect as possible. 
 
* Please read Warranty and license agreement »Page 15 
 
 

Future developments 

The reason we started this project originally was to build a reliable program capable of 
fulfilling the task of Bible study tool with practical features helping the user to study more 
effectively. Through the development period we have added to this main objective an 
emphasis on flexibility. In our studies and research we have learned however that the true 
objective is the user himself.  
All future developments will be made with focus on our users. To prove that we are paying 
attention to their needs we are offering free support  to all through electronic or regular mail. 
You are not required to purchase anything to receive answers to your questions. We want to 
hear your comments, suggestions even criticism.  
Let’s discuss the future version of Theophilos together.   
 
 
 

Warranty and license agreement 

Definition of terms  
The term "Program" refers to Theophilos program. The term "Author" refers to Ivan Jurik, 
Datelinova 1, 821 01 Bratislava, Slovakia. The term "Add-on" refers to add-on modules of 
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Theophilos program. The term "Unlock code" refers to information that is necessary for proper 
functioning of specific Add-on. The term "Theophilos Library CD" refers to CD-ROM 
containing the Program and other files offered by Author. 
 
Copyright notice 
Theophilos™ is Copyright © 1997-2000, Ivan Jurik. All Rights Reserved. Theophilos and 
Jumplists are Trademarks of Ivan Jurik. The Program is protected by the copyright laws of 
Slovak Republic, the United States and international copyright treaties. 
 
License agreement 
Author hereby grants you a license to use the Program free of charge for unlimited time on 
unlimited number of computers. You may freely distribute Program in its original and 
unmodified format to others. You may include Program on CD-ROMs, shareware collections, 
Internet sites, Bulletin Boards and other media. 
 
This license does not apply to the content of Theophilos Library CD. You may not sell, lend, 
rent, lease or otherwise transfer or distribute copies of Theophilos Library CD or any files on 
Theophilos Library CD unless it is stated otherwise in accompanying documentation. Special 
distribution license is necessary if you want to distribute Theophilos Library CD. No special 
licensing is necessary for use in local network (LAN) environments. 
 
This license does not apply to Add-ons with Unlock code or if accompanying documentation 
clearly prohibits such use. Special license is necessary to use such Add-ons in network 
environments. You may not sell, lend, rent, lease or otherwise transfer or distribute such Add-
ons. 
 
Note: 
Program may be distributed on commercial and shareware CD-ROMs and other media as 
long as: 
1. The CD or other media clearly states that Theophilos is provided free of charge. 
2. You distribute Program only complete and unmodified in its original compressed form. 
3. No more than a reasonable CD duplication fee is charged. You must determine an average 
selling price per program on the CD by taking the list retail selling price of the CD and divide it 
by the number of programs on the CD. If this average selling price per program on the CD is 
calculated to be equal to or less than $1.00 (U.S. Currency) per program you may include 
Program for distribution on this CD without any other permission required. If the average price 
per program on the CD is greater than $1.00 per program, you MAY NOT distribute Program 
on your CD without a special licensing arrangement worked out with Author, as we feel you 
are trying to make a substantial profit off our free program. 
 
For all distribution of the Program beyond these terms a special licensing arrangement must 
be worked out with Author. 
 
Title  
Title, ownership rights and intellectual property rights in and to the Program and Add-ons shall 
remain a property of Author. This Agreement does not include the right to copy or sublicense 
the Program and Add-ons and is personal to you and therefore may not be assigned (by 
operation of law or otherwise) or transferred without the prior written consent of Author. You 
acknowledge that the Program and Add-ons in source code form remain a confidential trade 
secret of Author and/or his suppliers and therefore you agree not to attempt to decipher, 
decompile, disassemble or reverse engineer the Program and Add-ons or allow others to do 
so, except to the extent applicable laws specifically prohibit such restriction. This applies also 
to data structure format of Add-ons and therefore you also agree not to attempt to make the 
content of Add-ons directly accessible by other programs. You further agree not to modify or 
create derivative works of the Program. 
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Content  
Title, ownership rights, and intellectual property rights in and to the content of Add-ons is the 
property of the applicable content owner and may be protected by applicable copyright or 
other law. This License gives you no rights to such content. 
 
Disclaimer of warranty  
Since the Program is provided free of charge, the Program is provided on an "AS IS" basis, 
without warranty of any kind, including without limitation the warranties of merchantability, 
fitness for a particular purpose and non-infringement. The entire risk as to the quality and 
performance of the Program is borne by you. Should the Program prove defective, you and 
not the Author assume the entire cost of any service and repair. 
 
This disclaimer of warranty constitutes an essential part of the agreement. SOME STATES 
DO NOT ALLOW EXCLUSIONS OF AN IMPLIED WARRANTY, SO THIS DISCLAIMER MAY 
NOT APPLY TO YOU AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY FROM 
STATE TO STATE OR BY JURISDICTION. 
 
Limitation of liability  
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, 
OR OTHERWISE, SHALL AUTHOR OR HIS SUPPLIERS OR RESELLERS BE LIABLE TO 
YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, 
DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR 
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES.  IN 
NO EVENT WILL AUTHOR BE LIABLE FOR ANY DAMAGES, EVEN IF AUTHOR SHALL 
HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY 
CLAIM BY ANY OTHER PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO 
LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICABLE LAW 
PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME STATES DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO 
THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU. 
 
Termination 
Either party may terminate this Agreement immediately in the event of default by the other 
party. Upon any termination of this Agreement, you shall immediately discontinue the use of 
the Program. You may also terminate this Agreement at any time by destroying the Program 
and Add-ons and all copies thereof. Your obligations to pay accrued charges and fees shall 
survive any termination of this Agreement. 
 
Miscellaneous 
This Agreement represents the complete and exclusive statement of the agreements 
concerning this license between the parties and supersedes all prior agreements and 
representations between them. It may be amended only by a writing executed by both parties.  
THE ACCEPTANCE OF ANY PURCHASE ORDER PLACED BY YOU IS EXPRESSLY 
MADE CONDITIONAL ON YOUR ASSENT TO THE TERMS SET FORTH HEREIN, AND 
AUTHOR AGREES TO FURNISH THE PROGRAM AND/OR ADD-ON(S) ONLY UPON 
THESE TERMS AND NOT THOSE CONTAINED IN YOUR PURCHASE ORDER. If any 
provision of this Agreement is held to be unenforceable for any reason, such provision shall 
be reformed only to the extent necessary to make it enforceable, and such decision shall not 
affect the enforceability (i) of such provision under other circumstances or (ii) of the remaining 
provisions hereof under all circumstances. Headings shall not be considered in interpreting 
this Agreement. 
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Software and hardware requirements 

 
Following are minimum and recommended system configurations for use of Theophilos Bible 
Software: 
 
FREEWARE PACKAGE (one Bible version, dictionary and commentary) 
 
Minimum tested: 
 
Operating system: Windows 95/98 or Windows NT 4.0 

Processor: Intel 486/66 

Memory RAM: 8 MB 

Harddisk space before installation: 40 MB free 

Harddisk space after installation: 20 MB free 

Pointing device: mouse or equivalent 

Screen resolution: 640x480 

Color depth: 256 colors 

Sound (optional - required for  
sound recording and playback): Sound Blaster or compatible, microphone 

Audio compression installed  
(required for narration preview): Microsoft ADPCM 
 
 
Recommended for best program performance: 
 
Operating system: Windows 95/98 or Windows NT 4.0 or newer 
versions 

Processor: Intel Pentium 100 or higher 

Memory RAM: 16 MB or more 

Harddisk space before installation: 100 MB or more free 

Harddisk space after installation: 80 MB or more free 

Pointing device: mouse or equivalent 

Screen resolution: 800x600 or higher 

Color depth: 32K (high color) 

Sound (optional - required for  
sound recording and playback): Sound Blaster or compatible, microphone 

Audio compression installed  
(required for narration preview): Microsoft ADPCM 
 
 
Recommended harddisk space requirements for CD VERSION: 150 MB or more free if 
you wish to load all available Bible translations. 
 
This space is needed for Windows swap file which grows according to number of Bible 
versions loaded and number of opened files. You can save space by loading only those Bible 
versions you need for immediate study. In fact CD version is more space efficient  
(recommended for systems with smaller disk capacity) because it requires only approximately 
4 MB of harddisk space for installation. 
 
If you downloaded add-ons from Internet you need additional harddisk space for these files 
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(recommended only for systems with large disk space capacities). 
 
 

Configuring Theophilos for use in network environments 

Configuring Theophilos for network is very simple task to perform. Since data files (Bible 
versions, dictionaries, commentaries and other add-ons) may be shared over your existing 
network they may be installed in one network directory shared by other users. On client side 
installations of Theophilos you only need to change "Data files path »Page 80" or add network 
paths to "Additional search paths »Page 80" to point to this directory (please check your 
network system manual for proper syntax for network paths). 
 
Tip: 
We recommend to copy all files from Theophilos Library CD »Page 96 to shared network 
directory from which all client installations may be performed. 
 
You may setup network folders for users to save and access their personal user files (notes, 
topic books, jumplists). Path to such folder may be specified by "User files path »Page 80". 
 
 
Note: 
User files may not be shared. Theophilos will refuse to access such file if it is opened by other 
user. 
 
No special license is necessary for use in local network (LAN) environments. This does not 
apply to some add-on modules. Please read Warranty and License Agreement »Page 15. 
 
 

Best facts about Theophilos 

 
Wouldn't you agree that it is extremely affordable? It's FREE! 
 
Constantly growing number of add-on modules  most of which are available also as free 
downloads  on the Internet. Great number of Theophilos users are getting involved  in 
authoring of additional modules. 
 
Theophilos is multilingual . You can easily localize the program into your local language if 
none of the available languages suits your needs. 
 
An ideal Bible study software for use in network  environments . 
 
Exceptionaly accessible for visually impaired users  who rely on screen reading software. 
Direct support for Theophilos is already an integral part of Jaws for Windows(tm) so you do 
not need any additional scripts. 
 
It's extremely fast . Most Bible searches take less than 1 second (Pentium systems). 
 
Handles complex searches  - single word, multiple words or phrase with AND, OR, NOT 
case sensitive  and boolean  searches with wildcard  symbol and proximity  options in easy 
to use interface. Results of any search may be searched again  to narrow the search even 
more. Did you know that you can search your entire library  in Theophilos? 
 
It is highly configurable . It can look and feel just the way you want it. 
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You may change fonts  almost anywhere in the program. 
 
Every Bible program will let you read the Word. You can also HEAR it in Theophilos! 
 
Has advanced multimedia features. You can even record your own narration  or create 
presentation of God's Word with moving text, sound and pictures. Can you say 
MULTIMEDIA? Now you can. 
 
Play  that tune! Wave or MPEG layer 3 . Theophilos can handle it. Pictures are no problem 
either. Windows Bitmaps or JPEGs. And motion video ? Yes, AVI and MPG. 
 
Bible program with its own HTML viewer ? Yes, definitely. You can find tons of Christian 
writings, documents and even Bibles on the Internet. Most are ready for you to be 
downloaded so you can browse them off-line in Theophilos and take advantage of 
dictionaries, Bible context and other functions. You can even create your own HTML 
documents with special links for Theophilos ! 
 
Has multiple document interface. Any number of Bibles may be opened at the same time, 
even same version in multiple views .  
 
Reusable windows  are the best way to study more effectively. No more crowded desktops. 
 
Unlimited  number of add-on modules may be installed. We will even make custom  modules 
for you or you may create them yourself . 
 
Library manager  will help you to manage your growing library the way you like it. 
 
Synchronized view  of Bible texts and notes. You decide which windows should be 
synchronized. Two modes are available. 
 
Compare mode  where several bibles may be compared verse-by-verse in single window.  
 
Any Bible version in window may be switched  instantly to another through menu or hot keys. 
Or you can switch to any document  by dragging its icon from the Navigator to the desired 
window. 
 
All versions share a set of bookmarks  which are user definable through pop-up menu or hot 
keys. 
 
Unlimited  number of user note sets  and annotations to verses may be created and opened 
at the same time. Theophilos offers also creation of user dictionaries  (we call them topic 
books). And if you need special advanced handling of verse lists try our Jumplists™ . 
 
Any text can be copied to clipboard, saved to file or printed in 5 predefined layout styles 
through an intelligent Copier .  
 
Recognition  of verse references and instant jumps to verses. References may even be used 
in user notes or user topic books.  
 
We trust that you will appreciate these and many more features that we didn't mention here 
as you learn to know Theophilos better. 
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Troubleshooting 

 
Symptom:  "Not enough memory or disk space" error message. 
Remedy: You may not have enough memory or free disk space to run Theophilos in 

current setup. Try loading only few Bible versions on startup or clearing more 
free disk space. You may need also to close running applications and restart 
your computer (some resources may not be freed until system restarts). See 
also Minimum requirements »Page 19. 

Cause:  Not enough resources. 
 

 • 
 
Symptom:  In some configurations fonts don’t display correctly. 
Remedy: Try uninstalling some unused fonts from Windows fonts folder. Be careful to 

uninstall only those fonts that are not used by any application. 
Cause:  Too many fonts installed. 
 

 • 
 
Symptom: Extended characters in some languages don’t display correctly in Theophilos’ 

windows even if the selected font supports them. 
Remedy:  Change your font settings to display the correct script (character set). You 

may need to install an appropriate language support. 
Cause:  Incorrect font script selected.  
 

 • 
 
Symptom: Pictures in online help system do not redraw correctly. 
Remedy:  Your color display is set to 16 or 256 colors. Try to change this setting to 

higher setting (Control Panel/Display) if your hardware permits. If this is not 
possible adjust the size of help window so only one picture is displayed at a 
time. 

Cause:  Low color depth setting. 
 

 • 
 
Symptom: Mouse wheel does not work correctly. 
Remedy:  There is only MS Windows 98/2000 support for mice with wheels. In some 

configurations this may not work as expected. 
Cause:  There is no native support for mice with wheels in Windows 95. 
 
 

Theophilos and the visually impaired 

Much consideration has been taken to make our program accessible also for users that rely 
on screen reading software to read all information from the computer screen. We have been 
cooperating with some of our blind users who helped us to fine tune our Bible software so you 
can now enjoy it using your favourite screen reader system »Page 23. Much attention has 
been paid also to blind user's special needs and our software comes equiped with all comfort 
of command through the keyboard. All functions and features are easily accessible and we 
hope that the result of our efforts will be greater ease of use. 
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If you are a user of "Open Book Unbound" or similar software we offer a new idea for you to 
use your scanned texts. Scribe for Theophilos »Page 13 authoring software may just be 
another dimension for sharing your texts with many thousands of users of Theophilos around 
the globe or in your local church. With Scribe for Theophilos you may convert all your 
scanned or typed texts to an add-on module for Theophilos. Modules that you create will 
appear in Theophilos' menu just as any other add-on and you can then take advantage of all 
features that Theophilos offers. You may exchange your modules with other users of 
Theophilos, pastor or friends and soon you will have a quite wealthy library for your 
enjoyment. If this idea sounds like it could make a difference, you can download your free trial 
copy of Scribe for Theophilos from our Internet site »Page 98 or you may find it on our 
Theophilos Library CD »Page 96. 
 
 
See also Use with screen reading software »Page 23, Move by lines »Page 76 
 
 

Use with screen reading software 

Theophilos should be able to work with most screen reader systems. One of the most popular 
of them is Jaws for Windows from Henter-Joyce (www.hj.com). We have contacted Henter-
Joyce to test Theophilos with their system and it has been found compatible with Jaws for 
Windows (JFW). The makers of Jaws have included additional special support for Theophilos 
directly into their latest release of the product so you will not need to install any additional 
scripts. 
 
Many of our users who use this reader system are already enjoying the power and ease of 
use of Theophilos Bible Software. While there is no other software necessary to use 
Theophilos with screen reading systems, if you are a Jaws for Windows user you can take the 
full advantage of the built-in support for Theophilos. This will make your study experience 
even more enjoyable and offer you a better control of the program in Jaws for Windows. If you 
find Theophilos a little intimidating with the wealth of functions and features the built-in 
support will introduce Theophilos to you and teach you to use it in the most effective way. 
Please note that you must have Jaws for Windows version 3.7 or higher installed on your 
computer system to take advantage of this support. If you have older version please contact 
Henter-Joyce for upgrade. 
 
 
Setting Theophilos for use with screen reading software: 
 
If you use Theophilos with any screen reading software there is one important setting in 
Theophilos that you should pay attention to. Theophilos utilizes two movement modes for the 
cursor in Bible windows. In normal mode which is also the default, the cursor is static in the 
upper left corner of the window. By using the UP/DOWN arrow keys the Bible text moves by 
verse at a time. In this mode your reader will not be able to read a complete verse but only 
the first line as it appears in window (the rest wraps itself on following lines). To be able to 
move the cursor by lines instead of by verses you will first have to select this option in 
Settings/Bible dialog window »Page 73. This will allow the cursor to be freely moved by lines 
so your reader will be able to read every line of each verse. 
 
To change the movement mode go to Settings dialog, select the Bible tab »Page 73 and 
check the Move by lines »Page 76 option. 
 
 
Note: 
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Much time and effort has been invested by Joseph K. Stephen from Henter-Joyce and Justin 
Daubenmire a dedicated JFW script writer and we want to thank both of these devoted men 
for their programming. 
 
For more information about Jaws for Windows screen reading software please contact 
Henter-Joyce at http://www.hj.com 
 
 
See also Theophilos and the visually impaired »Page 22, Move by lines »Page 76 
 
 

Copyright notices 

Theophilos™ is Copyright © 1997-2000, Ivan Jurik. All Rights Reserved. Theophilos and 
Jumplists are Trademarks of Ivan Jurik. Theophilos program is protected by the copyright 
laws of Slovak Republic, the United States and international copyright treaties. 
Please read also the Warranty and License Agreement »Page 15 . 
 
Graphic design, Theophilos logo and silhouette are Copyright © 1998-2000, Matus Tkac 
 
Maps are Copyright © 1998-2000, Ivan Jurik, Ladislav Rubint. Duplication prohibited. 
 
Illustrations are Copyright © 1998-2000, Ladislav Rubint. Duplication prohibited. 
 
Narrations available in free package and on Theophilos Library CD »Page 96 are Copyright © 
1998-2000, Stephen Jones. All rights reserved. 
"The Calling" sound clip is Copyright © 1998-2000, Stephen Jones. All rights reserved. 
Duplication of these files is prohibited without special agreement with author. Contact via 
Internet: http://www.comcat.com/~composer 
  
Alexander Scourby name and recording Copyright (cp) 1991 Litchfield Associates, Ltd. 
 
Alexander Scourby audio files Copyright (c) Audio Bible. All rights reserved. Duplication is 
prohibited. 
 
 
Music by Kerry Livgren: 
 
Intro music: excerpt from "And I Saw, As It Were… Konelrad" from the album "One Of Several 
Possible Musiks" Copyright © 1989 Kerry Livgren Productions, Inc. 
 
"All Creation Sings" from the album "Art Of The State" Copyright © 1985 Kerygmatic Music 
(BMI) 
"Beyond The Pale" from the album "Time Line" Copyright © 1984 Don Kirshner Music/EMI 
Blackwood Music Inc. (BMI) 
"Highway To The Heart" and "No Standing" from the album "Reconstruction" Copyright © 
1986 Kerygmatic Music (BMI) 
"I'll Follow You" from the album "Prime Mover" Copyright © 1988 Kerry Livgren Productions, 
Inc. 
"Just One Way" from the album "Seeds Of Change" Copyright © 1980 Don Kirshner 
Music/EMI Blackwood Music Inc. (BMI) 
"Racing Away" from the album "When Things Get Electric" Copyright © 1994 Kerygmatic 
Music/Art Street Music 
"Smoke Is Rising", "Two Thousand Down" and "When Things Get Electric" from the album 
"When Things Get Electric" Copyright © 1994 Kerygmatic Music 
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All music by Kerry Livgren is used by author's permission. Duplication is prohibited. 
 
 
Texts used in Theophilos: 
 
New American Standard Bible  and New American Standard Bible Update 
 
New American Standard Bible, Copyright (C) 1960, 1962, 1963, 1968, 1971, 1972, 1973, 
1975, 1977 by The Lockman Foundation. All rights reserved. 
 
New American Standard Bible Update, Copyright (C) 1960, 1962, 1963, 1968, 1971, 1972, 
1973, 1975, 1977, 1995 by The Lockman Foundation. All rights reserved. 
 
The "NAS", "NASB", "New American Standard" and "New American Standard Bible" 
trademarks are registered in the United States Patent and Trademark Office by The Lockman 
Foundation. 
 
PERMISSION TO QUOTE: 
 
The text of the New American Standard Bible® may be quoted and/or reprinted up to and 
inclusive of five hundred (500) verses without express written permission of The Lockman 
Foundation, providing the verses do not amount to a complete book of the Bible nor do the 
verses quoted account for more than 25% of the total work in which they are quoted. 
 
Notice of copyright must appear on the title or copyright page of the work as follows: 
 
"Scripture taken from the NEW AMERICAN STANDARD BIBLE, © Copyright The Lockman 
Foundation 1960, 1962, 1963, 1968, 1971, 1972, 1973, 1975, 1977. Used by permission." 
 
Or if quotations are from NASB 1995 text: 
 
"Scripture taken from the NEW AMERICAN STANDARD BIBLE, © Copyright The Lockman 
Foundation 1960, 1962, 1963, 1968, 1971, 1972, 1973, 1975, 1977, 1995. Used by 
permission." 
 
When quotations from the NASB® text are used in not-for-sale media, such as church 
bulletins, orders of service, posters, transparencies or similar media, the abbreviation (NASB) 
may be used at the end of the quotation. 
 
This permission to quote is limited to material which is wholly manufactured in compliance 
with the provisions of the copyright laws of the United States of America and all applicable 
international conventions and treaties. 
 
Quotations and/or reprints in excess of the above limitations, or other permission requests, 
must be directed to and approved in writing by The Lockman Foundation, PO Box 2279, La 
Habra, CA 90631, (714)879-3055. Web site: http://www.gospelcom.net/lockman 
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HOLY BIBLE, Old and New Testaments (Slovak translation). From original languages 
translated by prof. Jozef Rohacek. 
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This text is used by permission of the copyright holder. Distribution and usage of this text is 
not allowed without a written permission of the copyright holder. 
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New Testament KMS (Czech translation)  
Copyright © 1994, Christian Mission Society Foundation. Used by permission. Do not 
distribute. 
For information and licensing contact: Christian Mission Society Foundation, Andrstova 4, 180 
00 Praha 8, Czech Republic, phone: ++420/2/6833505, e-mail: kms@ecn.cz 
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Czech ecumenical translation 
Copyright © Czech Bible Society. Used by permission. Do not distribute. 
For information and licensing contact: Czech Bible Society, Thakurova 3, 160 00 Praha 6 - 
Dejvice, Czech Republic, phone: ++420/2/201 81 412, fax: ++420/2/243 15 723 
 
Nová Bible Kralická 
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New Bible Kralicka 
Copyright © 1999 by Association for New Bible Kralicka. Used by permission. Do not 
distribute. 
For information and licensing contact: Association for New Bible Kralicka (NBK), Rudolfovska 
11, 370 01 Ceske Budejovice, phone: + 420 38 635 54 96, e-mail: m.didonato@mbox.vol.cz 
 
The King James Version 2000 with Strong's Numbers  
 
Copyright (c) 1999 by International Bible Translators, Inc. All Rights Reserved. Unauthorized 
duplication is prohibited. 
 
The Revised Strong's Hebrew-Aramaic Dictionary  
 
Copyright (c) 1999 by International Bible Translators, Inc. All rights reserved. Unauthorized 
duplication is prohibited. 
 
The Revised Strong's Greek Dictionary  
 
Copyright (c) 1999 by International Bible Translators, Inc. All rights reserved. Unauthorized 
duplication is prohibited. 
 
 
Other texts 
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Daily Bible Reading, The Preacher's Library, Sinners in the Hands of an Angry God, 
Thompson's Chain Topics, A Gospel Tract add-ons were created by Dr. J. D. "Doc" Watson, 
Sola Scriptura Ministries, 1041 Cleveland, Meeker, CO 81641 
This ministry provides many other add-ons to Theophilos. Visit their web page: 
www.gospelcom.net/ccmag/ssm 
 
All other texts are to our best knowledge in public domain or otherwise freely distributable and 
are provided free of charge. Many of them were used by permission from Christian Classics 
Ethereal Library, Department of Computer Science, Wheaton College, Wheaton, IL 60187. 
Other sources include several electronic text libraries accessible over Internet. Some texts 
were donated to the project by dedicated users of Theophilos and their original source could 
not be traced. 
 
 

Your Theophilos advantage in electronic publishing 

 
The computer age in which we live offers great opportunities for the publishers of textual and 
multimedia content, but also requires them to upgrade their line of products and offer the 
printed works in electronic form. The term "computer generation" is not a fiction any more, but 
a reality. Young and old alike are using computers to access information over Internet, buy 
electronic books on CDs and read electronic magazines. The reason is very simple. Today's 
technology offers them a better alternative to get the information they need quickly and more 
efficiently. 
 
Producing your own CD product does not have to be a nightmare 
 
While producing a CD product may seem to be a complicated task we did everything possible 
to make it easy , time efficient  and affordable . It does not matter whether you want to make 
a CD with your church lectureships for simple browsing and searching or a full featured 
interractive multimedia library with richly formatted texts and hyperlinks referencing other 
documents and topics, pictures, sounds, graphs or Internet pages. You can even produce 
documents in HTML if you wish. No matter how you decide, you can be sure that Theophilos 
will not be too small nor too big for your project. And it will surely fit in your budget - that is our 
promise and your "Theophilos advantage". 
 
Shop arround! 
 
Before you decide which engine you will choose for your product you may wish to shop 
arround a bit. We do not mind and we certainly do understand. Our confidence is based on 
the fact, that we have made the research ourselves. You will find great products with high 
license fees or low cost products with limited functionality. We offer the best of both worlds: 
great product and service at reasonable cost. This is due to the fact that we are small 
independent software developers with very low operating costs compared to large software 
companies with number of employees and high bills to pay. So since we do not employ a 
janitor or a secretary you do not have to pay for their salaries. 
 
Electronic publishing can be affordable without sacrificing the quality 
 
Our latest line of Theophilos products was designed to let you stay on top in this fast growing 
industry. With Theophilos and its authoring capabilities you are able to design and create 
multimedia library of literary works which your customers will love to use. We can back this 
statement by the fact that Theophilos has more than 100,000 loyal users  arround the world 
and many dedicated authors of add-on modules. There have been already thousands of 



Theophil.RTF Theophilos help Page 28 of 109  

CDs sold  by those publishers that have based their products on Theophilos engine. Our 
references include publishers like Abilene Christian University Press , Freed-Hardemann 
University , International Bible Translators , Audio Bible, Inc . and many smaller publishers. 
If you are commited to excellence like us and satisfaction of your customers is important to 
you, then why not join the club. It is easy and exceptionally affordable. Whether you are a 
large publishing house or a small local church we would love to talk to you. 
 
To discuss your ideas and publishing plans please contact Ivan Jurik at vana@theophilos.sk  
or call +421 905 263 837 between 11am and 3pm EST if you call from USA or between 5pm 
and 9pm from most of Europe. 
 
You may also write to: 
 
Ivan Jurik 
Theophilos Bible Software 
Datelinova 1 
821 01 Bratislava 
Slovak Republic 
 
See also: Publishing and distributing your own CD products »Page 28, Distribution of 
Theophilos »Page 29 
 
 

Publishing and distributing your own CD products 

 
We have designed Theophilos to be flexible and affordable enough to fill the need in the 
electronic publishing market for tools that are user friendly to satisfy the needs of the average 
user but at the same time powerful and sophisticated enough to meet the requirements of the 
publishers of electronic texts. In Theophilos you have a reasonably priced reader engine for 
publishing various types of information. While Theophilos is known primarily as Bible software 
you do not need to look for other product if you desire to publish and distribute documents 
that are not necessarily only religious in nature. The program can operate in two modes and 
unless you include also Bible texts on the CD it will operate as a general literature reader . 
So you can publish classical works, poetry, manuals, company sheets and other documents 
as well. 
 
To distribute CDs with Theophilos engine you will need a special license from us. We require 
a small royalty fee for all commercial distribution, but the cost of licensing Theophilos will 
surely fit your budget and we guarantee the lowest price on the market . 
 
But that is not all. We will closely work with you and help you with the production of your CD 
product until it is actually released. We will even create a master CD for you for mass 
production of CD copies. But our commitment does not end here. We offer free technical 
support to all your customers for unlimited time . 
 
And here comes the best part of our offer: there are no up-front fees or bills to pay . We do 
not charge for the assistance offered during the development stage of your CD product and 
you will never be billed for it. Since the royalties for Theophilos are due only after the CDs are 
actually sold you are at no risk . Our success is dependent on yours. How is that for a deal? 
 
To discuss your ideas and publishing plans please contact Ivan Jurik at vana@theophilos.sk  
or call +421 905 263 837 between 11am and 3pm EST if you call from USA or between 5pm 
and 9pm from most of Europe. 
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You may also write to: 
 
Ivan Jurik 
Theophilos Bible Software 
Datelinova 1 
821 01 Bratislava 
Slovak Republic 
 
See also: Theophilos advantage »Page 27, Distribution of Theophilos »Page 29, General 
literature reader »Page 82 
 
 

Distribution of Theophilos 

 
Our distribution policy 
 
In most cases Theophilos is free to use and distribute and it can be classified as "freeware". 
However, this policy is limited only to the free package available on our website and it is 
further limited by the License Agreement. According to it, the free package can only be 
distributed over Internet, BBS and other electronic media. If distributed on CDs Theophilos 
cannot be the featured program, but only a part of larger collection of other programs or as a 
bonus application. According to the License Agreement, any distribution must be free of 
charge, and it must be clear from the packaging or documentation that Theophilos is offered 
as such. Furthermore, no modifications are allowed and the program must be in original 
compressed form. Any distribution beyond these guidelines must be authorized by the 
Distribution Agreement or special License Agreement. 
 
Distributing Theophilos Library CD 
 
We have a special program for interested distributors and resellers who wish to distribute our 
products. If you are an organization that would like to participate in this program, we would 
love to talk to you. We offer special wholesale prices to our distributors and you don't even 
have to carry the stock. We can ship all orders directly to your customers. This option may be 
very appealing especially to electronic bookstores and software vendors. All you have to do is 
take the order, collect the payment and e-mail to us your customer's address. We take care of 
the rest. 
 
Whether you want to sell Theophilos Library CD over-the-counter or through mail-order 
please contact Ivan Jurik at vana@theophilos.sk for more information and a copy of the 
Distribution Agreement. 
 
See also: Theophilos advantage »Page 27, Publishing and distributing your own CD products 
»Page 28 
 
 

Encryption and copy protection 

 
Since we understand how valuable your works are we did everything we could to protect your 
copyrighted work from possible misuse. This version of Theophilos uses encryption technique 
in the module files so that there is no way they could be used in other application successfuly.  
 
In addition, if you have licensed a Professional edition of Scribe for Theophilos »Page 13 to 
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create your own modules you have the option of protecting your data by limiting the export 
and printing of a particular document in Theophilos. You can totally disallow these features if 
you wish, however the clipboard function will still work in Windows. 
 
You can distribute your data in a locked state so without a special unlock code the module is 
totally unusable for the user since it will not be opened by Theophilos and the information it 
contains cannot be accessed by any standard application. 
 
However, you should always keep in mind that computer data can never be 100% safe and 
that the only true protection is your copyright notice.  
 
 
 

Keyboard shortcuts 

General 
 
Ctrl+P  Show Copier, print pictures and HTML documents 
Ctrl+C  Copy selection 
Ctrl+Insert Copy selected text with formatting 
Ctrl+V  Paste from clipboard 
Ctrl+T  Show settings dialog 
F1 Show help 
Alt+Enter  Show verse reference under cursor in context 
Alt+F4  Close application 
Ctrl+H  Document history window 
Ctrl+Shift+H  Window history window 
Ctrl+< and Ctrl+>  move in the document history 
Ctrl+Shift+< and Ctrl+Shift+>  move in the window history 
F8 shows, activates or hides the Navigator 
Alt+R  Reusable window mode toggle 
Ctrl+PgDown  in dictionaries, notes and writings moves to the next topic 
Ctrl+PgUp  in dictionaries, notes and writings moves to the previous topic 
Ctrl+D  displays the dictionary pop-up window (same as double-click, 
but you must select the word manually) 
 
Bible 
 
Ctrl+M  Toggle compare mode 
Ctrl+X  Copy verse 
Ctrl+Z Copy reference 
Shift+Ctrl+[position]  Set bookmark at position 
Ctrl+[position]  Go to bookmark at position 
Ctrl+Q  Toggle synchronized mode 
Arrows  Move by one verse 
Ctrl+PgDown, Ctrl+PgUp Move by one chapter 
Alt+PgDown, Alt+PgUp Move by one book 
PgDown, PgUp Move by number of verses displayed in window 
Ctrl+Home Go to first verse 
Ctrl+End Go to last verse 
Ctrl+Down  or Ctrl+Up  moves the caret without moving the verses (like "Move by 
lines" option) 
Alt+[1-0]  Colors 1-10  
Ctrl+Alt+[1-4]  Colors 11-14 
Ctrl+Alt+5  No color 
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Enter  Put current verse into history 
 
Dictionary/Topics 
 
Ctrl+I  Create new topic book 
Shift+Ctrl+A  Add new topic 
Ctrl+S  Save topic book 
Ctrl+Del  Delete current topic 
Ctrl+A  Select all text 
 
Commentary/Notes 
 
Ctrl+N  Create new note set 
Alt+Down  Next note 
Alt+Up  Previous note 
Ctrl+Down  Next verse 
Ctrl+Up  Previous verse 
Ctrl+Enter  Note for active verse 
Ctrl+Alt+Enter  Go to current note verse in the Bible 
Ctrl+K  Toggle bind to Bible mode 
Ctrl+S  Save note set 
Ctrl+A  Select all text 
 
Jumplist 
 
Ctrl+L  Create new jumplist 
Ctrl+A  Add new jump 
Enter  Jump to verse 
Ctrl+E  Edit description 
Ctrl+S  Save jumplist 
Ctrl+M  Merge with other jumplist 
Ctrl+Del  Delete jump 
Alt+Up/Down  Move the jump's position up or down in unsorted mode 
 
Multimedia 
 
F9 Toggle verse sound 
F10 Toggle verse picture 
F11 Toggle autoplay 
F12 Start/Stop recording 
Alt+X  Stop recording or playback  
Shift+Ctrl+M  Attach sound or picture to current verse 
Arrows  Move the picture within view 
PgUp, PgDown  Move the picture within view by larger steps 
+ Zoom-in picture by 25% (max. 200%) 
- Zoom-out picture by 25% (min. 25%) 
 
Find 
 
Ctrl+F  Show Finder 
Ctrl+Shift+F  Show document search dialog 
F3 Find next word occurrence (document search) 
Ctrl+Shift+D Look up word in open dictionaries and topics 
Ctrl+R  Search existing results 
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Finder 
 
Alt+[version number]  Search in different version 
Alt+Ins  Append selected word to search text input box 
 
Window 
 
Shift+Ctrl+T  Tile windows 
Shift+Ctrl+C  Cascade windows 
Shift+Escape  minimize Theophilos' main window 
F4 Previous window 
F5 Next window 
Ctrl+F4  Close current window 
 
 
 

Menus and commands 

Main menu 
 
(to get help on specific item click on the item) 
 

 
Bible »Page 38, Dictionary »Page 42, Commentary »Page 43, Writings »Page 43, HTML 
»Page 44, Topics »Page 44, Notes »Page 45, Jumplist »Page 49, Multimedia »Page 51, Find 
»Page 53, Publish »Page 63, Window »Page 67, Program »Page 69 
 
 
Information displayed in main window’s status bar : 
Library titles  – number of installed study resource modules 
Versions loaded  – number of versions available for browsing 
Active version  – Bible version last selected in window. Some functions use this information 
for further processing. 
Active verse  – Bible verse last selected in any version window. Some functions use this 
information for further processing. 
Current window setup  – name of the window setup as defined by the user 
 
 
Bible version window pop-up menu 
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Switch version »Page 39 
Compare mode »Page 40 
Go to book > »Page 40 
Finder »Page 53 
Find in dictionary topics »Page 60 
Copier »Page 63 
Copy »Page 65 
Copy verse »Page 66 
Copy reference »Page 66 
Set bookmark for [verse name] > »Page 40 
Go to bookmark > »Page 41 
Synchronized »Page 41 
Coloring »Page 41 
Bind notes »Page 42 
Font settings »Page 82 
Reusable »Page 39 
Module information »Page 39 
Close window »Page 69 
 
Information displayed in version window’s status bar : 
Reusable status  – informs if the window is marked as reusable 
Verse name  – the verse currently under cursor. If the window is active this verse is also the 
active verse 
Book number  – this is the position of the book in the Bible version 
Verse number  – this is the position of the verse in the Bible version 
Sync: ON/OFF  – informs about the window’s Synchronized »Page 41 option status 
 
Dictionary/Topics window pop-up menu 
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Context of [verse name] »Page 48 
Add topic »Page 45 
Save »Page 45 
Save as... »Page 45 
Copier »Page 63 
Copy »Page 65 
Paste »Page 66 
Delete topic »Page 67 
Find in dictionary topics »Page 60 
Search »Page 61 
Font settings »Page 82 
Reusable »Page 39 
Module information »Page 39 
Close window »Page 69 
 
Information displayed in dictionary or topic book window’s status bar : 
Reusable status  – informs if the window is marked as reusable 
Empty by default  – if Find in dictionary »Page 60 function is unable to locate the text in 
particular dictionary list of topics, message will be displayed here 
 
Commentary/Notes window pop-up menu  
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Context of [verse name] »Page 48 
Next note »Page 47 
Previous note »Page 47 
Next verse »Page 47 
Previous verse »Page 47 
Note for [verse name] »Page 46 
Save »Page 46 
Save as... »Page 46 
Copier »Page 63 
Copy »Page 65 
Paste »Page 66 
Find in dictionary topics »Page 60 
Search »Page 61 
Bind to Bible »Page 48 
Moving mode > »Page 49 
Font settings »Page 82 
Reusable »Page 39 
Module information »Page 39 
Close window »Page 69 
 
Information displayed in commentary and user notes window’s status bar : 
Reusable status  – informs if the window is marked as reusable 
Verse reference 1  – points to the closest existing note preceding the current. “None” is 
displayed if not available 
Verse reference 2  – points to the closest existing note following the current. “None” is 
displayed if not available 
Bind: ON/OFF  - informs about the window’s Bind to Bible »Page 48 option status 
 
Writings window pop-up menu 
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Context of [verse name] »Page 48 
Copier »Page 63 
Copy »Page 65 
Find in dictionary topics »Page 60 
Search »Page 61 
Font settings »Page 82 
Reusable »Page 39 
Module information »Page 39 
Close window »Page 69 
 
Information displayed in writings window’s status bar : 
Reusable status  – informs if the window is marked as reusable 
 
HTML window pop-up menu 
 

Context of [verse name] »Page 48 
Print »Page 44 
Copy »Page 65 
Find in dictionary topics »Page 60 
Search »Page 61 
Font settings »Page 82 
Reusable »Page 39 
Module information »Page 39 
Close window »Page 69 
 
Information displayed in HTML window’s status bar : 
Reusable status  – informs if the window is marked as reusable 
Target link  – shows target link URL 
 
Jumplist window pop-up menu 
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Add [verse name] »Page 51 
Context of [verse name] »Page 48 
Edit »Page 51 
Save »Page 50 
Save as... »Page 50 
Merge with... »Page 50 
Copier »Page 63 
Copy »Page 65 
Copy verse »Page 66 
Copy reference »Page 66 
Paste »Page 66 
Delete jump »Page 67 
Search »Page 61 
Sort by > »Page 50 
Reusable »Page 39 
Module information »Page 39 
Close window »Page 69 
 
Information displayed in jumplist window’s status bar : 
Reusable status  – informs if the window is marked as reusable 
Jump number  – number of selected jump in the list 
Number of verses  – displays number of verses currently contained in Jumplist 
 
Search results window pop-up menu  
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Context of [verse name] »Page 48 
Finder »Page 53 
Search these results »Page 62 
Find in dictionary topics »Page 60 
Copier »Page 63 
Copy »Page 65 
Copy verse »Page 66 
Copy reference »Page 66 
Delete verse »Page 67 
Font settings »Page 82 
Reusable »Page 39 
Close window »Page 69 
 
Information displayed in search results window’s status bar : 
Reusable status  – informs if the window is marked as reusable 
Version name abbreviation [range]  – Bible version and range of books that were searched 
in a particular search. If existing results were searched “[Results]” will display instead of 
actual range 
Hits, verses, seconds  – informs you about number of found instances of searched word(s) 
or phrase, number of verses where these instances occur and the length of time in seconds it 
took to find them 
 
 
Switch version > »Page 39 
Compare mode »Page 40 
Go to book > »Page 40 
Set bookmark for [verse name] > »Page 40 
Go to bookmark > »Page 41 
Synchronized »Page 41 
Coloring »Page 41 
Bind notes »Page 42 
[version name(s)] »Page 42 
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Bible menu 
Switch version 

Applies to version windows. 
 
Version text in any version window may be switched to any other available version instantly. If 
possible Theophilos will preserve the position of the text. 
 
 
See also Opening a Bible version »Page 42, Compare mode »Page 40, Reusable windows 
»Page 39 
 
 

Reusable windows 

One of the unique features of Theophilos are the reusable windows. When studying the Bible 
along with other texts very soon you will find your desktop cluttered with open windows which 
can greatly reduce the quality of the study. Frequent closing and reopening of the necessary 
documents can often cause loosing your focus of your study. The solution is the reusable 
window which will greatly help to minimize this by reusing any already opened window for 
display of a new document without having to open a new window. 
 
There are several approaches to taking advantage of this functionality. You can either drag 
and drop an icon from the Navigator »Page 70 on any window or mark any one or more 
windows as reusable. This will cause the program to use the current or last active reusable 
window to automatically accept the document's text for display. When you double click an 
icon in Navigator or select the document from the menu the text will display in a reusable 
window changing its content. 
 
In addition, each window keeps track of all documents that were displayed in it in a special 
window history record. 
 
To mark any window as reusable, right-click with your mouse while in the window's area and 
select Reusable from the pop-up menu or click on the appropriate icon in the History toolbar 
or press Alt+R keys when the desired window is currently the active window. 
 
See also Document history »Page 69, Window history »Page 69 
 
 

Module information 

Activating this command will display information about the active module if such information 
file was provided by the module author »Page 13. 
 
See also Creating modules for Theophilos »Page 13, Licensing Theophilos »Page 28 
 
 

Reference toolbar 

If you prefer to enter the verse reference by typing it directly to get to any verse quickly you 
may do so with the verse reference input box. This is hidden by default so you will have to 
change the setting in the Program/Toolbars menu to display the reference toolbar. 
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See also Navigator »Page 70, Localization of Theophilos »Page 87 
 
 

Bible menu 
Compare mode 

This powerful command allows user to compare several Bible versions in single window. In 
this mode only one verse from all selected versions is displayed. If not all versions can fit into 
the window try resizing the window, adjusting its font size or prevent certain versions from 
displaying in this mode (e.g. you may want to exclude versions opened in other windows). 
 
Tip: 
Some versions have different number of verses, or verse numbering does not correspond 
with others. In this case the first version in the list is held to be dominant. If you want a 
different version to be at the first position use Switch version »Page 39 command. 
 
 
See also Opening a Bible version »Page 42, Settings/Bible section »Page 73, Synchronized 
»Page 41, Reusable windows »Page 39 
 
 

Bible menu 
Go to book 

Just one of the fast and intuitive ways of navigating through the Bible in Theophilos. Gets you 
to the book of your choice instantly. 
 
See also Navigator »Page 70, Go to bookmark »Page 41, Keyboard shortcuts »Page 30, 
Document history »Page 69 
 
 

Bible menu 
Set bookmark for [verse name] 

Bookmarks come very handy if you want to mark several passages you often recall. You can 
set up to ten bookmarks which are being shared by every Bible version. When setting a 
bookmark first click on the verse you want to mark. This verse becomes the active verse 
throughout the program. Click on Set bookmark for [name of verse you picked]. Theophilos 
shows all current bookmarks with verse names they point to (Genesis 1:1 by default). Choose 
one you want to replace with your new bookmark. 
 
Tip: 
For more advanced way of bookmarking verses and for creating lists of verses use jumplists 
»Page 49 instead. 
 
See also Go to bookmark »Page 41  
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Bible menu 
Go to bookmark 

Gets you to the verse you bookmarked previously with Set bookmark »Page 40 command. 
 
See also Navigator »Page 70 
 
 

Bible menu 
Synchronized 

With this command you may toggle your preference of having the content of active version 
window move in accord with all others which have this option also checked. Great feature 
when comparing several versions. 
 
Note:  
Some versions use different verse numbering as others. Theophilos tries to synchronize 
versions based on verse names (e.g. 3 John 1:14). If you find that the text content of 
compared verses differs use manual synchronization instead of automatic. This setting may 
be selected in Settings dialog under Bible tab »Page 73. While in Compare mode »Page 40 
only automatic synchronization is used. 
 
Tip:  
You may have one primary version opened in one window and all others in a different window 
with Compare mode option checked. This way while browsing only one version you may 
compare it with all other versions without taking up much desktop space. 
 
You can also drag and drop any version on any existing window from the Navigator. The 
window text will switch to new version at the place of the previous version. 
 
See also Opening a Bible version »Page 42  
 
 

Bible menu 
Coloring 

With this command you may toggle your preference of having the text of active Bible version 
window appear colored. If this mode is turned on you can color any selected portion of text 
using the color palette on the toolbar. 
 
To color the text, first turn the coloring on for the selected Bible window, select the desired 
portion of text with your mouse or keyboard and either click on the desired color or press an 
appropriate key combination »Page 30. 
 
You may define your own colors in the palette by holding a Ctrl key while clicking on the color 
button you desire to change. All coloring in the Bible will change from old to new color 
instantly. For example if you change the value of red the words of Christ in the King James 
Bible will change their color accordingly. 
 
You will find that your KJV Bible now features Jesus' words in red. Open your KJV Bible and 
turn the coloring on by clicking on the appropriate icon or right clicking the mouse on the Bible 
text and select coloring there. Then move to any of the Gospels and look for text in red. Is it 
there? Praise the Lord! 
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Tip: 
You may share your Bible coloring with other users. If you create a richly colored Bible 
version in Theophilos you may offer your coloring scheme to others. All you need to send is 
the file with the abbreviated name of the Bible version and the COL extension. For example, if 
the abbreviated name of the Bible is "KJV" then look for the "kjv.col" file in Theophilos' 
program folder. This file contains all coloring for the KJV Bible. However, be aware that users 
may redefine the default color values so the colored text may appear in different colors than in 
your copy of Theophilos. 
 
 
See also Opening a Bible version »Page 42  
 
 

Bible menu 
Bind notes 

With this option checked you link current version window and all commentary/note windows, 
so that their content movements are synchronized. To move notes automatically version 
window must be active and commentary/note windows must have Bind to Bible »Page 48 
option checked. 
 
Tip: 
If you don't want certain commentary/note set to move automatically make sure the Bind to 
Bible »Page 48 option of that particular window is unchecked. 
 
 
See also Synchronize »Page 41  
 
 

Bible menu 
Opening a Bible version 

Any number of version windows may be opened at any time. Even same version in multiple 
windows. This allows for compares of Bibles, books, chapters, etc. 
 
Note: 
Number of versions listed here depends on number of versions loaded. 
Many Bible versions as well as other resource materials are available as add-ons to 
Theophilos software. Please see information about Theophilos Library CD »Page 96 for 
further details. 
 
There is no limit set in Theophilos software on number of installed, loaded and opened Bible 
versions. The only limit is the amount of available memory and disk space on your computer. 
 
See also Navigator »Page 70, Switch version »Page 39, Compare mode »Page 40, 
Synchronized »Page 41, Reusable windows »Page 39 
 
 
[dictionary name(s)] »Page 42  
 
 

Dictionary menu 
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Opening a dictionary 

To open dictionary simply click on its name. Dictionary items are added to this menu 
dynamically whenever you install a new dictionary along with an appropriate key. 
There is no limit set in Theophilos software on number of add-ons installed and opened at any 
time. The only limit is the amount of available memory and disk space in your computer. 
 
Tip: 
Double clicking on a word in any Theophilos document will open a special Dictionary pop-up 
window. You can flip through all your installed dictionaries there to see the definition of the 
selected word. This technique works also within the pop-up window itself so you may double 
click on words there also. 
 
Note: 
This menu will not be available if there are no dictionaries installed. 
Please see Theophilos Library CD »Page 96 section about information how to obtain 
dictionaries, commentaries, Bible versions and other resource materials as add-ons to 
Theophilos. 
 
See also Reusable windows »Page 39 
 
 
Next note »Page 47 
Previous note »Page 47 
Next verse »Page 47 
Previous verse »Page 47 
Note for [verse name] »Page 46 
Bind to Bible »Page 48 
Moving mode > »Page 49 
[commentary name(s)] »Page 43 
 
 

Commentary menu 
Opening a commentary 

To open commentary simply click on its name. Commentary items are added to this menu 
dynamically whenever you install a new commentary along with an appropriate key. 
There is no limit set in Theophilos software on number of add-ons installed and opened at any 
time. The only limit is the amount of available memory and disk space in your computer. 
 
Tip: 
Double clicking on a verse reference in the Bible window will open a special Commentary 
pop-up window. You can flip through all your installed commentaries there to see the notes on 
the selected verse. 
 
Note: 
This menu will not be available if there are no commentaries installed. 
Please see Theophilos Library CD »Page 96 section about information how to obtain 
dictionaries, commentaries, Bible versions and other resource materials as add-ons to 
Theophilos. 
 
See also Reusable windows »Page 39 
 
 
[writing's name(s)] »Page 44  
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Writings menu 
Opening a writing 

To open writing simply click on its name. Writing items are added to this menu dynamically 
whenever you install a new writing along with an appropriate key. 
There is no limit set in Theophilos software on number of add-ons installed and opened at any 
time. The only limit is the amount of available memory and disk space in your computer. 
 
Note: 
This menu will not be available if there are no writing files installed. 
Please see Theophilos Library CD »Page 96 section about information how to obtain 
dictionaries, commentaries, Bible versions and other resource materials as add-ons to 
Theophilos. 
 
See also Reusable windows »Page 39 
 
 
Open... »Page 44  
[HTML document name(s)] »Page 44  
 
 

HTML menu 
Opening a HTML document 

To open a HTML document you can click on Open command and browse to a directory where 
you store your HTML files. Then select a file to open. HTML files can be added to this menu 
by renaming the extension of the desired HTML file to TML. This file must reside either in 
Theophilos program directory, directory defined by the Data path or in one of the directories 
defined in the Additional search paths. When the program starts it will search these paths for 
files to add to your library. 
 
See also Reusable windows »Page 39 
 
 

Printing a HTML document 

To print a HTML document press Ctrl+P when the document is active, or click the Print 
command in the Publish menu. The print dialog will let you choose the page range and other 
print settings. 
 
New book »Page 45 
Open... »Page 45 
Save »Page 45 
Save as... »Page 45 
Add topic »Page 45 
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Topics menu 
New book 

Creates new topic book. You may create as many of these books as you see fit. New file will 
be created in the folder designated by the "User files path". See Settings/Paths section »Page 
73 for more information. 
 
 

Topics menu 
Open... 

Opens existing topic book. Open dialog opens in the folder designated by the "User files 
path". See Settings/Paths section »Page 73 for more information. 
 
 

Topics menu 
Save 

Saves topic book. Optionally user files may be saved automatically. See 
Settings/Miscellaneous section »Page 73 for more information. By default Theophilos creates 
backup copies of user files before any changes are saved. 
 
 

Topics menu 
Save as... 

Saves current topic book under new name. Original topic book remains intact. 
 
 

Topics menu 
Add topic 

Adds new topic to the topic book. Number of topics contained in one topic book is not limited. 
If the topic has no name when it is saved it will be named “untitled” automatically. The name 
of the topic cannot be changed after it is saved. 
 
Note: 
When new topic is saved it is given the name currently displayed in the topics drop-down box. 
When saving new topics make sure that correct name is displayed here. To prevent any 
inconsistencies of naming topics try to save the new topic with correct name as soon as 
possible. After topic is saved Theophilos will not allow changing its name. 
 
Tip: 
To change the name of the topic after it is saved use following procedure: 
Select all text in the topic window (Ctrl+A). Copy the selected text to the clipboard with the 
Copy command. Now add new topic and give it a new name. Paste the text previously copied 
to the clipboard with the Paste command. Save changes with the Save command. Go to the 
topic with the original name and delete it with the Delete item or Delete topic command. 
 
 
New set »Page 46 
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Open... »Page 46 
Save »Page 46 
Save as... »Page 46 
Next note »Page 47 
Previous note »Page 47 
Next verse »Page 47 
Previous verse »Page 47 
Note for [verse name] »Page 46 
Bind to Bible »Page 48 
Moving mode > »Page 49 
 
 

Notes menu 
New set 

Creates new note set. You may create as many of these sets as you see fit. New file will be 
created in the folder designated by the "User files path". See Settings/Paths section »Page 73 
for more information. 
 
 

Notes menu 
Open... 

Opens existing user note set. Open dialog opens in the folder designated by the "User files 
path". See Settings/Paths section »Page 73 for more information. 
 
 

Notes menu 
Save 

Saves user notes. Optionally user files may be saved automatically. See 
Settings/Miscellaneous section »Page 73 for more information. By default Theophilos creates 
backup copies of user files before any changes are saved. 
 
 

Notes menu 
Save as... 

Saves current user note set under new name. Original note set remains intact. 
 
 

Notes menu 
Note for [verse name] 

Displays the note for active verse. To make other verse active click on that verse in version 
window. If note for that verse does not exist window displays message "No note". 
 
Tip: 
Drop down list box in notes window lists all available notes. Use this tool to get to any note 
directly. 
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See also: Next note »Page 47, Previous note »Page 47, Next verse »Page 47, Previous 
verse »Page 47  
 
 

Notes menu 
Next note 

Jumps to next existing note. 
 
Tip: 
Drop down list box in notes window lists all available notes. Use this tool to get to any note 
directly. 
 
 
See also: Previous note »Page 47, Next verse »Page 47, Previous verse »Page 47  
 
 

Notes menu 
Previous note 

Jumps to closest previous existing note. 
 
Tip: 
Drop down list box in notes window lists all available notes. Use this tool to get to any note 
directly. 
 
 
See also: Next note »Page 47, Next verse »Page 47, Previous verse »Page 47  
 
 

Notes menu 
Next verse 

Displays note for the following verse. If no note exists for that verse window displays message 
"No text". 
 
 
See also: Next note »Page 47, Previous note »Page 47, Previous verse »Page 47  
 
 

Notes menu 
Previous verse 

Displays note for the preceding verse. If no note exists for that verse window displays 
message "No text". 
 
 
See also: Next note »Page 47, Previous note »Page 47, Next verse »Page 47  
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Context of [verse name] 

Verse represented by a reference under cursor is displayed in the first available version 
window. If no Bible version window is currently opened a new window will be opened to 
display the verse. If you have more than one Bible window opened click on the window that 
you desire to display the context (making it the active window), return to window with the 
reference and use the command again. 
This feature comes handy in many dictionaries, commentaries, outlines and reference 
materials where many verse references occur. Theophilos can recognize most of these 
references provided that a proper syntax is used. Before any library add-on is made available 
we provide a recognition file that allows Theophilos to recognize the reference style used. 
Authors of textual content can create recognition files that will enable Theophilos to recognize 
the verse references correctly. 
 
Tip (does not apply to jumplists): 
You may use references even in your notes and topic books. Only make sure you use the 
following syntax: 
[BookAbbreviation]<space>[ChapterNumber]:[VerseNumber] 
Optionally you may use comma to separate single verses, dash for range of verses, 
semicolon to separate single chapters. A reference then may look something like this:  
 
Mt 17:14  
 
or like this:  
 
Mt 14:17, 19, 25; 22:15-20; 23; 2Th 3:5  
 
Try this in your notes and topics! 
For book names abbreviations you may use those that are appropriate for the language you 
use or you may create your own set. 
 
 
Tip: 
If the verse reference is not recognized properly make sure the cursor is over the chapter or 
verse part of the reference. Check the syntax, especially make sure no extra spaces or other 
punctuation is used. Make sure the reference is displayed on one line (try resizing the 
window). While this is usually not necessary there may be some cases when this helps. Use 
proper short book names. You may use the ones appropriate for the language you use. You 
can have them displayed in the Navigator's »Page 70 Bible tab if the Use short book names 
»Page 79 option is checked. 
 
Note: 
If used in search result window and jumplist this command will similarly show the verse under 
cursor in context. 
 
See also Localization of Theophilos »Page 87 
 
 

Notes menu 
Bind to Bible 

With this option checked content of note window is moved automatically whenever any 
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version window is browsed. Bind notes »Page 42 option of version window must be checked 
also. Combining these options on some windows you may very powerfully customize your 
desktop and thus enhance your browsing and study experience. 
 
 
See also Synchronized »Page 41, Moving mode > »Page 49  
 
 

Notes menu 
Moving mode 

Another one of the helpful features to power-browse the Bible and resource works. Two 
modes are available: Smart mode and Normal mode.  
 
Smart mode  
If selected only existing notes are displayed. If the verse has no associated note, note window 
displays the closest previous existing note. This way you may see notes that cover whole 
passages of the Bible without losing the focus of proper note. You may try this feature with 
Matthew Henry's Commentary »Page 43 as an example. 
 
Normal mode  
Notes move with every verse even if note does not exist. In that case "No text" is displayed. 
 
Note: 
Bind to Bible »Page 48 and Bind notes »Page 42 (version window) options must be checked 
for automatic movement to work. 
 
 
 
New list »Page 49 
Open... »Page 49 
Save »Page 50 
Save as... »Page 50 
Merge with... »Page 50 
Sort by > »Page 50 
Add [verse name] »Page 51 
Edit »Page 51 
 
 

Jumplist menu 
New list 

Creates new jumplist. You may create as many jumplists as you see fit. New file will be 
created in the folder designated by the "User files path". See Settings/Paths section »Page 73 
for more information. 
 
 

Jumplist menu 
Open... 

Opens existing jumplist. Open dialog opens in the folder designated by the "User files path". 
See Settings/Paths section »Page 73 for more information. 
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Jumplist menu 
Save 

Saves jumplist. Optionally user files may be saved automatically. See Settings/Miscellaneous 
section »Page 73 for more information. By default Theophilos creates backup copies of user 
files before any changes are saved. 
 
 

Jumplist menu 
Save as... 

Saves current jumplist under new name. Original jumplist remains intact. 
 
 

Jumplist menu 
Merge with... 

One of the ways how to create jumplists automatically is merging several together. Content of 
the jumplist selected in the Merge jumplist dialog will be added to the currently active jumplist, 
thus combination of these two will be created. 
 
Tip: 
You may create jumplists automatically also by exporting the results of a Bible search into a 
jumplist. See Copier »Page 63 topic for more details. 
 
 

Jumplist menu 
Sort by 

Jumplist may be sorted chronologically (in the order as verses appear in the Bible), in 
alphabetical order of verse descriptions or it can be displayed as unsorted list. Alphabetical 
order is especially useful if you provide your own descriptions instead of automatically 
generated ones. Unsorted option comes handy if you wish to have your jumplist ordered 
according to certain topics or in any custom order. The sorting mode is saved with each 
jumplist so when you open a jumplist it is sorted the way it was saved. 
 
Tip: 
You may quickly change the order by clicking on the column headers of the jumplist. 
 
When in unsorted mode, you can move the jumps up or down in the list by holding the ALT 
key and pressing UP and DOWN arrows. 
 
See also Adding a jump to jumplist »Page 51 
 
 



Theophil.RTF Theophilos help Page 51 of 109  

Jumplist menu 
Add [verse name] 

This command adds active verse to the list instantly. To change the active verse simply click 
on the desired verse in any Bible window.  
 
Tip: 
Theophilos will automatically generate description for every new verse in the jumplist by 
extracting specified number of first letters from the verse. It uses active Bible version text for 
description. See Settings/Other documents section »Page 73 on how to change the number 
of letters for the auto-descriptions. You may edit the descriptions with the Edit command 
»Page 51. 
 
 

Jumplist menu 
Edit 

This command will allow you to edit the descriptions generated automatically by the program. 
 
 
Open... »Page 51 
Verse sound »Page 51 
Verse picture »Page 52 
Autoplay »Page 52 
Stop »Page 52 
Record »Page 52 
Attach media to [verse name] »Page 52 
 
 

Multimedia menu 
Open... 

Opens multimedia files. Depending on filter in the open dialog used only picture or sound files 
are shown. Only pictures in the Windows Bitmap (*.bmp) or JPEG compressed (*.jpg) format 
are currently supported. In case of sound Wave files (*.wav) and MPEG layer 3 (*.mp3) files 
are currently recognized and motion video (*.avi and *.mpg) are supported only through an 
installed external motion video player. 
 
Note: 
You must have sound system installed and properly configured in order to play sound files. 
To play compressed Wave files you must have sound compression support installed in 
addition. 
 
 

Multimedia menu 
Verse sound 

Plays sound currently attached to the active verse. If this option stays checked corresponding 
sound is played every time a verse with sound attached becomes the top verse in the active 
Bible window. 
 
Note: 
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You may record your own sounds for every verse in the Bible. See Record command »Page 
52 for more details. 
 
 

Multimedia menu 
Verse picture 

Opens special picture window used to display pictures attached to verses. If this option stays 
checked corresponding picture is shown every time a verse with picture attached becomes 
the top verse in the active Bible window. 
 
 

Multimedia menu 
Autoplay 

This feature will let you play sounds and show pictures in multimedia presentation of God's 
Word. 
 
Note: 
You may create your own narration »Page 52 and attach own pictures »Page 52 and thus 
customize presentations for different types of audiences from children to adult. 
 
 

Multimedia menu 
Stop 

This command stops the Autoplay feature »Page 52 and ceases playback of any sound. 
 
 

Multimedia menu 
Record 

Custom sounds, e.g. your own audio verse notes or narration of the Bible may be recorded 
without leaving Theophilos' program interface. While recording a red LED light is flashing on 
the Multimedia toolbar. 
 
Note: 
Recording is possible only if sound system is properly installed and configured. You must 
have a working microphone attached in addition to be able to record your voice. 
 
Tip: 
Try to make your recordings as efficient as possible as sound files take much space on your 
harddisk. You may customize the quality and efficiency of sound files in the 
Settings/Multimedia »Page 73 section. 
 
 

Multimedia menu 
Attach media to [verse name] 

You may attach existing sound or picture file (depending on dialog file filter used) to every 
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verse in the Bible. This is useful to produce multimedia presentations of God's Word which 
will surely attract the attention of your audience. 
 
Note: 
Sound and picture files are copied to new location according to verse name. Therefore be 
careful when attaching many copies of large files as this may take up much disk space. 
 
 
Finder »Page 53 
Find in dictionary topics »Page 60 
Search this document »Page 61 
Find next »Page 62 
Context of [verse name] »Page 48 
Search these results »Page 62 
 
 

Find menu 
Finder 

 

 
 
Search text input box »Page 54 
Wildcard symbol »Page 55 
Logical NOT symbol »Page 55 
Case sensitive »Page 56 
Search mode »Page 56 
Allowed number of verses apart »Page 56 
Search in: »Page 57 
Create new window »Page 57 
<< button »Page 57 
Words list edit box »Page 57 
Words list »Page 58 
Help »Page 58 
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Close »Page 58 
Range »Page 58 
Find »Page 59 
 
Font settings »Page 60 
 
 

 
 
Search text input box »Page 60 
Whole words only »Page 60 
Case sensitive »Page 56 
Searching documents »Page 60 
Help »Page 58 
Close »Page 58 
Toggle »Page 60 
Find »Page 59 
Find next »Page 59 
 
 

Finder dialog 
Search text input box (Bible mode) 

Here you enter text you want to search for. You may use an asterisk or wildcard character (*) 
at the beginning or end of any incomplete word. Use a tilde character (~) to separate words 
not to be included in the search. For ease of input of these characters use the Wildcard 
symbol »Page 55 and Logical NOT symbol »Page 55 buttons. 
 
Example: 
 
*dish* ~ *honour 
 
this will search for verses containing words reddish, dish, dishes, Dishan but not dishonour 
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Note: 
If more than one logical NOT operators are encountered only first one is taken into respect. 
 
Any punctuation except asterisk (*), logical NOT operator (~) and apostrophe ( ' ) will be 
ignored. All searches are case insensitive until the case sensitive option is turned on. 
 
Theophilos discerns between words with and without an apostrophe (e.g. Aaron's is a unique 
word and therefore is treated as such in searches). 
 
When the case sensitive option is set you must use exact letter case to get the desired 
results. 
 
 
See also Words list »Page 58  
 
 

Finder dialog 
Wildcard symbol 

Wildcard symbol - asterisk (*) is used when searching for incomplete words. This symbol can 
be placed at the beginning and/or end of the word.  
 
Example: 
 
dis* 
This will search for all words starting with "dis" e.g. dish, Dishan, dishonour 
 
*ron 
This will search for all words ending with "ron" e.g. Aaron, Hebron, iron 
 
*ron* 
This will search for all words with "ron" anywhere in the word e.g. iron, strong, wrong 
 
See also Search text input box »Page 54  
 
 

Finder dialog 
Logical NOT symbol 

Logical or boolean operator NOT is used in searches to filter out words not to be included in a 
search. Typical use is in conjunction with a wildcard character (*) where use of the asterisk 
would produce unwanted words to be searched for.  
 
Example: 
 
dis* ~ dishonour 
 
This will search for all words starting with "dis" except the word "dishonour" 
 
Note: 
This option will not exclude entire verses if other conditions of the search are met for a 
particular verse. 
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See also Search text input box »Page 54  
 
 

Finder dialog 
Case sensitive 

Makes your searches case sensitive. You must use exact letter case to get the desired 
results. 
 
 

Finder dialog 
Search mode 

Depending on your requirements you may choose from three search modes. 
 
Find verses containing: 
 
Any word  
Result will include verses containing any one, all or any combination of words in any order 
specified in Search text input box »Page 54. 
 
All words  
Result will include only verses where all specified words appear. Order of words may vary. 
Only in this mode proximity search »Page 56 option is available. 
 
Phrase  
Only verses containing specified words in specified order will be found. 
 
Note: 
You may use the wildcard symbol »Page 55 (*) and logical NOT symbol »Page 55 (~) in any 
of these search modes. 
 
Tip: 
Try complex searching capabilities of Theophilos by searching the search results over with 
different search specifications.  
 
Try this example using King James Version: 
 
1. Do a search for words "david" and "king" in "All words" mode. 
2. Use "Search these results »Page 62" command and search again for "king over israel" with 
“Phrase” mode set. 
 
In the first step 154 verses will be found. In the next step only 8 verses on the subject of 
David beeing a king over Israel will be filtered out. 
 
 
 

Finder dialog 
Allowed number of verses apart 

This powerful option will allow for proximity searching by specifying number of verses 
searched words can be apart from each other. This advanced searching method is necessary 
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when searching for certain group of words that should appear close to each other in the Bible 
yet not necessarily within the same verse. 
 
Note: 
This option is available only in "All words" search mode. 
 
Example: 
Try searching for "Peter" and "keys" and specify 1 verse proximity. Theophilos will find two 
verses - one with the word "Peter" and other with "keys" neighboring with each other. 
 
 
 

Finder dialog 
Search in 

Switches the Bible version to be searched. Words list »Page 58 - if showing - is updated. 
Theophilos can switch to appropriate version automatically every time the Finder »Page 53 is 
invoked if the Smart version switching »Page 79 option is checked. 
 
Tip: 
Right-clicking anywhere in the Finder will show a pop-up menu to let you quickly switch to 
different version »Page 57. Alternatively you may use a Alt+[version number] key 
combination. 
 
 
 

Finder dialog 
Create new window 

When checked Theophilos creates new results window every time a search is performed. 
Thus you may have several search results windows opened at any time. 
 
Tip: 
You may use this option to do many different searches based on results of one or more 
previous search results. There is no limit on how deep and complex your searches may 
become. 
 
 
See also Search existing results »Page 62 
 
 

Finder dialog 
<< button 

Copies word from Words list edit box »Page 57 and appends it to the Search text input box 
»Page 54. Double clicking on the Words list »Page 58 or Alt+Insert key combination may be 
used instead. 
 
 
 

Finder dialog 
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Words list edit box 

Here you can input any word to quickly find out if the word is contained in particular version. If 
so the word will be highlighted in the Words list »Page 58. As you type Theophilos will try to 
find the closest matching word.  
 
Tip: 
Clicking on the list will put the highlighted word into the Words list edit box. 
Double click will append the word to Search text input box »Page 54. 
 
 

Finder dialog 
Words list 

A complete list of all words contained in selected version of the Bible. 
 
Tip: 
Clicking on the list will insert the highlighted word into the Words list edit box »Page 57. 
Double click will append the word to Search text input box »Page 54. 
 
 
See also Search in: »Page 57 
 
 

Finder dialog 
Help 

Opens this online help file. 
 
 

Finder dialog 
Close 

Closes the Finder dialog without performing any search. 
 
 

Finder dialog 
Range 
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Use this dialog to confine the search to specified range of books. Use the buttons as 
shortcuts for selecting pre-defined ranges as indicated by their captions.  
 
Tip: 
Double clicking will select the same book in the opposite listbox. 
 
 
See also Search in: »Page 57 
 
 

Finder dialog 
Find 

This command executes the search. If the Search text input box is empty or no verse 
matching the search criteria is found the message box will appear. Input some text to search 
for or close the dialog by Close »Page 58 button.  
 
 

Finder dialog 
Find next 

Finds next occurrence of the searched character string in the document beginning from the 
current position. 
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Finder dialog 
Toggle 

Toggles all selected documents. Check marked items become unchecked and vice versa. 
 
 

Finder dialog 
Font settings 

Generally there is no need to change the default font for Finder dialog. For some foreign Bible 
versions there may be necessary to use a different font character set. Theophilos does this 
automatically, if you have installed an appropriate language support in Windows operating 
system. For Greek versions you must have Theophilos Greek Normal font installed. This font 
may be found in Theophilos' program folder or on Theophilos Library CD »Page 96. You must 
install it yourself using common MS Windows™ routine for installing fonts. 
 
 

Finder dialog 
Search text input box (Library mode) 

Here you enter text you want to search for. 
 
 

Finder dialog 
Whole words only 

Turn this option on if you wish to search for whole words (as typed in the search text box). 
Otherwise substring search will be performed searching for words that contain the search 
string. 
 
 

Finder dialog 
Searching documents 

You may search any document in your library in Theophilos. You decide if you want to search 
only the currently active document or several documents in one search. 
 
 

Find menu 
Find in dictionary topics 

This advanced feature allows you to search topics of all open dictionaries (at least one needs 
to be opened) for the selected text. If found dictionary will jump to the found topic, else it will 
display a "No matches for [selection]" message in its status bar. Any opened user topic books 
will be searched as well. 
 
Note: 
This command works in all types of windows. You have to select text prior to using this 
command. Theophilos will try to match the selected text exactly or, if it doesn't succeed, as 
close as seems reasonable.  
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To search the text content of dictionary instead of its topics use Search this document 
command »Page 61. 
 
Tip: 
Try to keep selections as short as possible for better results. A more powerful feature is the 
dictionary/commentary pop-up window. If you double-click with your mouse on any word in 
any document a special window will open to let you select any of the installed dictionaries. If 
you double-click on the verse reference in Bible windows the window will offer commentaries 
instead. 
 
 

Find menu 
Search this document 

 

 
 
Text to search for »Page 61 
Whole words only »Page 62 
Case sensitive »Page 62 
Find first »Page 62 
Find next »Page 62 
Close »Page 62 
 
Any document in Theophilos may be searched through this dialog (for Bible windows use 
Finder dialog instead). Theophilos will find text also in user files including notes, topic books 
and jumplists. 
 
Tip: 
To search specific document make its window active (click on it) then activate the search 
dialog again. 
 
You may also search the entire library of all installed documents in one step using the Finder 
dialog. 
 
 

Text search dialog 
Text to search for 

Input some text to search for in the document. All searches are case insensitive and substring 
matches are performed. 
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Text search dialog 
Whole words only 

Turn this option on if you wish to search for whole words (as typed in the search text box). 
Otherwise substring search will be performed searching for words that contain the search 
string. 
 
 

Text search dialog 
Case sensitive 

Makes your searches case sensitive. You must use exact letter case to get the desired 
results. 
 
 

Text search dialog 
Find first 

Finds the first occurrence of the searched character string in the document. 
 
 

Text search dialog 
Find next 

Finds next occurrence of the searched character string in the document beginning from the 
current position. 
 
 

Text search dialog 
Close 

Closes the dialog.  
 
 

Find menu 
Search these results 

This advanced feature helps narrowing down the search by searching the results of previous 
search. To be specific, in this mode Finder »Page 53 searches only verses in particular 
results window. Number of such searches is unlimited, until you get the results you want.  
 
Note:  
You may have unlimited number of search results windows open. To search a specific 
window first activate that window (click on that window) and then invoke the Finder by this 
command. 
 
 
See also Delete item »Page 67 
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Copier »Page 63 
Copy »Page 65 
Copy verse »Page 66 
Copy reference »Page 66 
Paste »Page 66 
Delete item »Page 67 
 
 

Publish menu 
Copier 

 

Copier is an advanced tool for most outputs from Theophilos software. It allows you to copy, 
save or print any and all texts from Bible versions, notes, commentaries, dictionaries or even 
jumplists and search results. If you have time and enough paper in your printer you can even 
print the whole Bible. While this is probably an extreme and unreasonable use of the Copier 
tool we only want to illustrate its possibilities. 
 
Note: 
The export and printing of some documents may be limited due to copyrights. In some special 
cases the export and printing may not be allowed at all. This is not a limitation of Theophilos, 
but an option for the publishers and copyright holders of certain works. 
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Most common uses of the Copier are printing of user notes for archiving or other purposes, 
copying of larger amounts of text or verses and pasting them into your favorite word 
processor. Copier allows even exports of search results into jumplists for later reference or 
various study purposes. 
 
Copier can use any window as the source for the output (except HTML documents). To select 
the source simply click on the desired window so that this window becomes the active 
window. Now activate the Copier (click on the speed button or menu command). Copier will 
inform you about the source it will use in its caption bar. Copier works in two modes 
(switching between them is done automatically without the user intervention) depending on 
the source window.  
 
If the source is a Bible version, commentary, user note set, jumplist or search results  
window you may select the range of verses for output. As a built-in feature Copier will 
automatically select the relevant range of verses (in case of Bible version this is the currently 
active verse, in case of commentary or note set the first and last existing note, in case of 
jumplist first and last verse jump and in case of search results the first and last of found 
verses). This range of course may be adjusted to allow you to select only portion you wish to 
use for the output.  
 
Next you select the output target which may be the Windows clipboard, file or any printer 
accessible from your computer. If the source window is search results window you have a 
choice to export to jumplist in addition. 
 
If source window is a jumplist you are allowed to choose the content of the output to be the 
reference description or actual text of the referenced verse. 
 
If available choose the Bible version used for the output. This choice is available only for Bible 
version, search results and jumplist windows. 
 
There are 5 predefined output styles you can choose from. Try switching between them to 
see the final outlook and select one that will suit your needs.  
After you execute the output it may be interrupted any time by pressing the Escape key on 
your keyboard.  
 
Other options allow you to choose only verse references as the output, use long or short Bible 
references and whether the text should be sent as plain text or formatted. 
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The Copier starts in dictionary mode if the active window is a dictionary, writing or user 
topic book . Here you may select one or more topics for output. To select more then one hold 
Ctrl key while selecting single topics or Shift key when selecting range of topics.  
 
 
The use of output target selector is the same in both modes. You also have the option to send 
the text as plain text or formatted. 
 
 
Note: 
When printing, Copier will use the font settings of source window (as displayed in example 
box). If you wish to print in different font change these font settings. As an exception default 
font settings of Bible windows are used for jumplists. 
 
 
 

Publish menu 
Copy 

Applies to all windows. 
 
This command copies selected text to clipboard. When copying larger amount of text use 
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Copier »Page 63 tool instead. 
 
Note: 
In jumplist this command copies entire verse reference with description. This can be then 
pasted into different jumplist. 
 
Tip: 
This command will copy text without the formatting. To copy the text with all formatting use 
the Ctrl+Ins key combination »Page 30. 
 
See also Copy verse »Page 66, Paste »Page 66  
 
 

Publish menu 
Copy verse 

Applies to version, results windows and jumplists. 
 
Copies single verse under cursor to clipboard. It is not necessary to select all of the text. The 
verse under cursor is copied in its entirety and verse reference is placed at the end. This is 
very helpful when quoting from the Bible. Verse can be pasted into any text editor (or user 
notes and user topic book). When copying of more then one verse is necessary use Copier 
»Page 63 tool instead. 
 
Note: 
If copying from jumplist text from active Bible version is used. To change active version switch 
to this version before copying. 
 
 
See also Copy selection »Page 65, Paste »Page 66  
 
 

Publish menu 
Copy reference 

Applies to version, results windows and jumplists. 
 
Copies single reference of verse under cursor to clipboard. It is not necessary to select any 
text. This is helpful when referring to Bible verse in your topic books or notes. The reference 
can be pasted into any text editor (or user notes and user topic book). When copying more 
then one reference would be desirable (i.e. the results of a Bible search) use Copier »Page 
63 tool instead. 
 
 
See also Copy selection »Page 65, Paste »Page 66  
 
 

Publish menu 
Paste 

Applies to user notes, user topic books and jumplists. 
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This command is used to paste text copied to clipboard from any Theophilos window or other 
Windows application. 
 
Note: 
In jumplist only verse jump from other jumplist can be pasted. 
 
 
See also Copy verse »Page 66, Copy selection »Page 65  
 
 

Publish menu 
Delete item 

Applies to user topic books, search results and jumplists. 
 
Depending on active window different action is performed. 
In user topic book  currently shown topic is deleted. 
In search result window  verse under cursor is deleted from list of verses found. This may 
come handy when doing complex searches, printing or saving the list of verses found and 
some should be excluded. 
In jumplist  selected jump is deleted. 
 
 
Tile »Page 67 
Cascade »Page 67 
Arrange icons »Page 68 
Full screen view »Page 68 
Minimize »Page 68 
Previous window »Page 68 
Next window »Page 68 
Document history »Page 69 
Window history »Page 69 
Close window »Page 69 
Close all windows »Page 69 
 
 

Window menu 
Tile 

Tiles all windows according to the Preferred tiling method »Page 74 setting. 
 
Note: 
Generally order in which windows were opened is kept. The order of windows in stack 
changes after Tile command is applied when current window becomes first in stack. 
 
See also Smart window tiling »Page 74 
 
 

Window menu 
Cascade 

Cascades all windows. 
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Window menu 
Arrange icons 

Arranges all minimized window icons. 
 
 

Window menu 
Full screen view 

Use this setting if you have a small monitor. Comes handy on notebook computers. Turn this 
setting on to maximize the program window, hide the caption bar and display the program 
over the Windows task bar. To return to normal view click this setting again. 
 
Tip: 
To save even more space you may wish to hide all toolbars by toggling the Show toolbars 
setting in Program/Toolbars menu. 
 
 

Window menu 
Minimize 

Minimizes the main program window to Windows task bar. 
 
 

Window menu 
Previous window 

Activates previous window. 
 
Note: 
Generally order in which windows were opened is kept. The order of windows in stack 
changes after Tile command is applied when current window becomes first in stack. 
 
 

Window menu 
Next window 

Activates next window. 
 
Note: 
Generally order in which windows were opened is kept. The order of windows in stack 
changes after Tile command is applied when current window becomes first in stack. 
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Window menu 
Document history 

Document history keeps track of places in the document. This is done automatically for each 
document that was displayed in a particular window. The document and window history 
records are closely cooperating and are kept in memory until the window is closed. 
 
This command displays the content of the document history record for the selected document. 
 
See also Reusable windows »Page 39, Window history »Page 69 
 
 

Window menu 
Window history 

Window history keeps track of previously displayed documents in a particular window. This 
means that you can switch back and forward between the documents in the same window 
without having to open them again.  
 
This command displays the content of the window history record for the selected window. 
 
See also Reusable windows »Page 39, Document history »Page 69 
 
 

Window menu 
Close window 

Closes active window. 
 
 

Window menu 
Close all windows 

Closes all opened windows. 
 
 
Language > »Page 70 
Settings »Page 73 
Navigator »Page 70 
Library manager »Page 71 
Toolbars »Page 73 
About Theophilos »Page 80 
Help index »Page 80 
Tips and tricks »Page 81 
Keyboard shortcuts »Page 81 
Menus and commands »Page 81 
Ordering add-ons »Page 81 
Unlock add-on module »Page 81 
Exit »Page 82 
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Program menu 
Language 

Allows switching to different language. The change is made immediately and there is no need 
to restart Theophilos. Note that Bible book names and their abbreviations are changed as well 
to correspond with selected language.  
 
Tip: 
Visit our Internet web site for new and updated language files and other useful add-ons.  
If you don't see your local language being offered you can create a new language plug-in 
yourself or contact us »Page 98 and help us create a language plug-in for you and all your 
fellow users in your country. If you have created a new language plug-in please let us know 
so that we may offer it free of charge on our Internet web site »Page 98 to other users of 
Theophilos. 
 
See also Localization of Theophilos »Page 87 
 
 

Program menu 
Navigator 

 

  
 
Library 
One of the great features of Theophilos is the organization and accessibility of library items. 
With hundreds of modules already available for Theophilos you can have them all nicely 
organized in a library tree always ready to be used. This is one purpose of the Navigator tool.  
 
You can open any document by double clicking its icon in the Navigator or by dragging its 
icon to any open window. If you have at least one window marked as reusable, the document 
will open in that window replacing its content. If you wish to open the document in a new 
window you can press and hold the Ctrl key while double clicking the document icon. The 
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same works if you open the document from the menu. 
 
Bible 
Other purpose of the Navigator is navigating the Bible text. Getting to any place in the Bible is 
a breeze. But if you'd rather prefer to enter the verse reference by typing it directly you may 
do so with the verse reference input box. This is hidden by default so you will have to change 
the setting in the Program/Toolbars menu. 
 
Results 
Finally, the Navigator will display also the results of a library search from the Finder tool. By 
double clicking the document icon the document will open with the first occurrence of the 
search string highlighted. You can then proceed to search further by pressing F3 until no 
more matches are found. 
 
 
Tip for using the Bible tab: 
Double clicking on any list box or hitting the "Enter" key on your keyboard is equivalent to 
clicking on the OK button. 
 
We have created a smaller version of Navigator's Bible tab we call "Mini Navigator". It can 
stay visible on the program's toolbar at all times for your convenience. Pressing Tab key while 
in the Bible window will shift the focus on Mini Navigator's controls. You may select the 
reference using the arrow keys and move from one edit box to the other with Tab key. When 
you are finished, just press Enter key to go to the reference of your choice. 
 
Note: 
Display of long or short Book names in the Navigator can be toggled in 
Settings/Miscellaneous section »Page 73. The display font may also be customized to suit 
your preference. Check the Settings/Fonts section »Page 73 topic for details. 
 
 

Program menu 
Library manager 
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Library manager will let you organize your library to your liking. With hundreds of modules for 
Theophilos available on Internet and several CD titles sold worldwide you will find this tool 
indispensable. The library structure that you create will be used in the Navigator's Library tree 
and also in the menus. 
 
The left panel shows the tree structure of your library, while the right panel shows the items 
contained by the currently selected folder on the left. 
 
The following example will show how you can easily organize your Bible versions (more Bible 
versions are accessible from the Theophilos Library CD). The same technique will work for all 
other types of documents: 
 
1. Open the Library manager 
 
2. Click on the Bible folder icon on the left panel (Menu tree). 
 
3. Click on the New menu button. 
 
4. Type in "Foreign versions" as the new menu item's title and press Enter when done. 
 
5. Click on the Bible folder icon again to show the Bible versions. 
 
6. Drag and drop the Bible versions from the right panel (Menu content) onto the newly 
created "Foreign versions" folder icon on the left (instead of drag and drop technique you can 
use the clipboard to move the icons. Click on Copy button to copy the selected version icons, 
select the desired folder icon on the left and click on the Paste button). 
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Program menu 
Toolbars 

This menu allows you turn on/off any toolbar. You may also choose to temporarily turn all 
toolbars off to save extra space on your monitor. 
 
 

Program menu 
Settings 

 
The following sections represent individual tab pages in the Settings dialog: 
 
Window section  
 
Smart window tiling »Page 74 
Prefered tiling method »Page 74 
Save window setup on exit »Page 74 
Save window setup now »Page 75 
Load window setup »Page 75 
 
Bible section  
 
Smart synchronization »Page 75 
Open in synchronized mode »Page 76 
Move by lines »Page 76 
Versions to load on startup »Page 76 
Choose on startup »Page 76 
Versions in compare mode »Page 77 
 
Other documents  
 
Open in smart moving mode »Page 77 
Use search version for context »Page 77 
Highlight color »Page 78 
Verse column width »Page 77 
Number of characters to use for autodescriptions »Page 77 
 
Fonts 
 
Default font settings »Page 78 
 
Multimedia section  
 
Use media from CD »Page 78 
Play sound on startup »Page 78 
Recording quality »Page 78 
 
Miscellaneous section  
 
Smart saving »Page 79 
Create backups »Page 79 
Remember dictionary pop-up position »Page 79 
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Finder opens in active version »Page 79 
Use short verse names when copying »Page 79 
Use short book names in Navigator »Page 79 
Copy italics in parenthesis »Page 80 
 
Paths section  
 
Data files path »Page 80 
Additional search paths »Page 80 
User files path »Page 80 
 
 

Settings – Window section 
Smart window tiling 

When checked and a new window is opened or closed all windows will be automatically 
rearranged to fit in the main Theophilos window.  
 
Note: 
You may wish to turn this option off for certain windows setups saved by Save window setup 
on exit »Page 74, or Save window setup now »Page 75 commands and if saved windows are 
being opened on startup. 
 
See also Preferred tiling method »Page 74, Tile »Page 67 
 
 

Settings – Window section 
Preferred tiling method 

Used in conjunction with Smart window tiling »Page 74 and Tile »Page 67 commands. 
Windows will be tiled according to your preference. 
 
 

Settings – Window section 
Save window setup on exit 

When checked Theophilos will remember the positions and setup of all opened windows upon 
closing of the application. Next time the program starts it will use these settings and will 
restore the application desktop, including opened Bible versions and verse positions, notes, 
etc. 
 
Note: 
The currently active desktop setup file is used. To change the active desktop setup file or 
create new one choose Save window setup now or Load window setup commands. 
 
See also Save window setup now »Page 75, Load window setup »Page 75 
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Settings – Window section 
Save window setup now 

You may prefer to have certain windows opened every time Theophilos starts or save several 
setups for different purposes. This may include Bible versions, notes, etc. This command will 
save the information about currently opened windows and main window, complete with their 
settings and positions on the screen. When the program starts it will use the last used 
desktop setup file to restore the application desktop. 
 
The desktop setup dialog will let you create new desktop setup file. You may title your 
desktop to best describe its purpose. You may create new desktop setup by entering its title 
and adding it to the list. 
 
Tip: 
If you wish to have these settings permanent make sure the Save window setup on exit 
»Page 74 options remains unchecked or they will be overwritten upon exiting the program.  
 
If you no longer wish to have any windows opened upon startup simply create a new setup or 
choose an existing one and save it while no windows are opened. 
 
See also Save window setup on exit »Page 74, Load window setup »Page 75 
 
 

Settings – Window section 
Load window setup 

You will be presented with a dialog to let you choose any previously saved desktop setup.  
 
See also Save window setup on exit »Page 74, Save window setup now »Page 75 
 
 

Settings – Bible section 
Smart synchronization 

Bible version windows can have their content synchronized which allows comparing several 
versions next to each other. When smart synchronization is used Theophilos will attempt to 
synchronize version text based upon verse names. Some versions use different verse 
numbering and the differences can be so large that Theophilos will no longer be able to 
synchronize texts correctly. If this is the case turn this option off and you will be able to 
synchronize individual windows manually based upon their content. 
 
To perform manual synchronization use following procedure: 
Turn Smart synchronization off. Activate first of the windows you wish to synchronize 
manually and turn its synchronized mode on. Activate next Bible window turn its synchronized 
mode off, position its content so it matches the content of the first window and turn its 
synchronized mode on. From this point these windows will keep their position as set. You can 
repeat this procedure on as many Bible windows as you wish. 
 
Tip: 
Try manual synchronization when comparing synoptical gospels within the same version by 
opening the same version in multiple views and using the above procedure. 
 
Note: 
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If Bible window is in Compare mode, Smart synchronization is used regardless of this setting. 
 
 

Settings – Bible section 
Open in synchronized mode 

When this option is checked Bible windows are opened in Synchronized mode. 
 
 

Settings – Bible section 
Move by lines 

This option will allow the cursor to be moved line by line instead of verse by verse which is 
necessary for the screen reader software used by visually impaired users to read every line 
as the cursor is moved. 
 
See also Theophilos and the visually impaired »Page 22, Use with screen reading software 
»Page 23 
 
 

Settings – Bible section 
Versions to load on startup 

When loading time and conserving memory is of concern you may choose to load only Bible 
versions you plan to use. While this is not recommended since it narrows your study 
possibilities you may find this feature necessary in some cases.  
 
Note: 
At least one version must stay selected (Theophilos will not allow deselecting of all versions). 
After you made your selection you must restart Theophilos for changes to take effect. 
Selected versions will be loaded next time the program starts. 
 
Note: 
Theophilos will start even if no Bible versions are found on startup. In this case the program 
will switch to general literature reader mode »Page 82 automatically. In this mode all Bible 
study related functions are disabled and hidden. You need to specify a correct path for Bible 
data modules or have the CD-ROM (if available) in your CD-ROM drive at all times when 
running the program to have the program switch back to Bible study mode. 
 
See also Choose on startup »Page 76, Reader mode »Page 82 
 
 

Settings – Bible section 
Choose on startup 

When checked a window will appear upon the start of the program to let you choose and 
confirm the loading of selected Bible versions. Helpful when conserving memory or loading 
time and changing the selection of loaded versions frequently. 
 
See also Load versions on startup »Page 76 
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Settings – Bible section 
Versions in compare mode 

You may choose only certain Bible versions to appear in a window with compare mode set. 
This may be necessary if many versions are loaded and some are not visible due to lack of 
available space. 
 
Note: 
Only loaded versions are listed here. 
At least one version must stay selected (Theophilos will not allow deselecting of all versions). 
 
See also Compare mode »Page 40, Load versions on startup »Page 76 
 
 

Settings – Other documents 
Open in smart moving mode 

When checked all notes will be opened in this mode. Otherwise normal mode is used. For 
more information relating this option see Moving mode > »Page 49 
 
 

Settings – Other documents 
Verse column width 

Changes the width of verse column in all opened and new jumplist windows. This will help 
when using non-default font settings for jumplist windows.  
 
Tip: 
You do not have to guess this setting since the widths are adjusted and changes are visible 
immediately when using keyboard arrows or small arrow buttons next to this edit box. 
 
 

Settings – Other documents 
Number of characters in auto-descriptions 

Theophilos will use this setting when creating auto-descriptions for new verse jumps added to 
jumplists. Number of actual characters may vary since Theophilos will not split words and will 
always add only complete words. The rest of incomplete verse is replaced with three periods 
(...). These are not added if the verse is complete. 
 
 

Settings – Other documents 
Use search version for context 

When checked and Context of [verse name] »Page 48 command is issued program looks for 
opened window with corresponding Bible version. If it doesn’t find one it will create it. If this 
option is turned off the first available Bible window is used to show the context regardless of 
Bible version. To have the context shown in any particular Bible window click on this window 
and return back to Search results window. 
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Settings – Other documents 
Highlight color 

In search results the words you were doing a search on are shown in different color. You may 
change this color to suit your preference. 
 
 

Settings – Fonts 
Default font settings 

Change these settings if you wish that all new windows use common font to display their 
content. Virtually all types of windows can have custom font set. If you use other then western 
character set especially in your user files you should change it here.  
 
Note: 
Individual font settings can be set in every window trough the pop-up menu but will be lost 
again when you close the window. Use default setting to make them permanent. 
 
Special case are Bible windows where default font settings are always used for verse 
reference (book, chapter and verse number) regardless of window's individual setting. 
 
 

Settings – Multimedia section 
Use media from CD 

This option is available only if there is Theophilos Library CD »Page 96 (or other CD with 
Theophilos) in your CD-ROM drive and Data files path »Page 80 points to it. If this option is 
checked all verse sounds and pictures are played from CD (if available). If you wish to listen 
to your own audio notes or narration turn this option off. 
 
 

Settings – Multimedia section 
Play sound on startup 

If you do not wish to listen to the opening music turn this option off. 
 
 

Settings – Multimedia section 
Recording quality 

Your recordings can have different sound quality. Keep in mind that better quality 
consumes more space on your harddisk.  Try these settings and use the one that  suits you 
best. 
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Settings – Miscellaneous section 
Finder opens in active version 

If this option is checked Finder »Page 53 will always switch automatically to active Bible 
version when opening. 
 
 

Settings – Miscellaneous section 
Smart saving 

When checked all changes in user files will be saved automatically without the user 
intervention. No confirmation dialog will display. Otherwise Theophilos will always ask the 
user to save or cancel the changes made. 
 
 

Settings – Miscellaneous section 
Create backups 

Backup file with original content is created every time a file is saved when this option is 
checked. 
 
 

Settings – Miscellaneous section 
Remember dictionary pop-up position 

When set the dictionary/commentary pop-up window will open at the position where it was 
last shown and will not follow the mouse cursor. 
 
 

Settings – Miscellaneous section 
Use short book names in Navigator 

In Navigator »Page 70 you may choose to display full names of the books or their common 
abbreviations. While full names are easier to navigate through, especially for those who are 
not yet familiar with the names of the Bible books, using abbreviations may save you some 
desktop space (depending on your Theophilos windows setup). 
 
Tip: 
You can customize the book names and book abbreviations by editing them in the language 
plug-in file. For more information click here »Page 87. 
 
 

Settings – Miscellaneous section 
Use short verse names when copying 

When checked Bible books abbreviations are used in verse references when copying verses 
to clipboard or using the Copier tool. 
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Settings – Miscellaneous section 
Copy italics in parenthesis 

If checked all Bible text in italics will be enclosed in parenthesis upon copying verse to 
clipboard or using the Copier tool. Otherwise normal text (no italics) will be copied. 
 
 

Settings – Paths section 
Data files path 

This path should point to folder containing the data files (Bible versions, dictionaries, etc.). 
Normally this is used to point to CD-ROM drive where Theophilos Library CD »Page 96 or 
other CD with Theophilos files can be found. However in special cases (in network 
configurations »Page 20 for instance) you may use this setting to point to other folder. If no 
Bible version is found in this and additional search paths upon the program startup 
Theophilos will switch to general literature reader mode »Page 82. 
 
Regardless of this setting Theophilos will always look first in folder it started from. This will 
allow for updates of data files should a newer version become available while preserving the 
value of the CD. 
 
 

Settings – Paths section 
Additional search paths 

You can add several paths here which will be searched when the program starts for modules 
to be added to Theophilos' library. 
 
 

Settings – Paths section 
User files path 

This setting should point to folder where you wish to keep your notes, topic books and 
jumplists. New files you create will be created in this folder. By default startup folder is used 
but this must be changed if you run Theophilos from CD as files cannot be created on CDs. 
 
 

Program menu 
About Theophilos 

Shows some information about the program. 
 
 

Program menu 
Help index 

Online help index. 
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Program menu 
Tips and tricks 

Tips and tricks on using Theophilos. 
 
 

Program menu 
Keyboard shortcuts 

Key combinations you can use to work with the program more effectively. 
 
See list of keyboard shortcuts »Page 30 
 
 

Program menu 
Menus and commands 

Explanation of commands found in the menus. 
 
 

Program menu 
Ordering add-ons 

Information about ordering additional modules. 
 
 

Program menu 
Unlock add-on module 

 

 
 
Some modules on Theophilos Library CD »Page 96 may be used only after a necessary 



Theophil.RTF Theophilos help Page 82 of 109  

license fee is paid (due to licensing policies of copyright holders). Until then they remain 
locked on the CD. After the fee is paid the user will receive the unlock code to be able to use 
such add-on module. For more information about availability of special add-ons please see 
the "theocd.txt" file on the CD or visit our Internet site »Page 98. 
 
If you have already received your code please follow these three steps: 
 
1. Type in the module name EXACTLY  as it appears in the documentation you have 
received. This means that you should use capital letters and any special characters where 
appropriate. 
 
2. Type in the unlock code. 
 
3. When you are finished with steps 1 and 2 press the Unlock button. 
 
If you receive an error message "Incorrect unlock code" you must repeat the procedure again 
from step 1. Be certain you enter the module name and unlock code exactly as shown in the 
documentation you have received with your CD. 
 
After you succeed (the program will inform you about this) you can enter the unlock 
information for other add-ons if you desire. When you are finished you must restart the 
program and new add-ons will be accessible from their appropriate menus. 
 
 
 

Program menu 
Exit 

Closes Theophilos application. 
 
 
 

Font settings 

This command will display font dialog to allow changes of font settings for current window. 
 
 

Opening documents 

Open dialog will let you choose the type of document to open with the filter edit box. All types 
of documents that Theophilos recognizes may be open including HTML documents, pictures, 
sounds and motion video files. 
 
 

General literature reader mode 

The primary use of the program is of course study of the Bible and other Christian writings. 
But Theophilos now serves two purposes: as a full featured Bible program and as general 
literature reader. The correct mode is chosen automatically by the program according to data 
modules found. If the program does not find any Bible texts, it will automatically choose the 
reader mode, since Bible functions would not serve any purpose. 
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You may find this useful in some cases to be able to use the program also at work for reading 
other literature and documents that do not have to be only religious in nature. These may 
include anything from poetry and fiction to technical manuals or other company documents. If 
your particular circumstances require that the program should act only as a general book 
reader then it will. 
 
Bible mode 
 
This mode will be used when at least one Bible version is found on start-up. Theophilos will 
act as a full featured Bible study application, allowing you to study the Bible text and do all the 
things you should expect from the Bible program. 
 
Reader mode 
 
In this mode all Bible study specific functions are disabled and relevant menu commands and 
other features are totally hidden. You will not find features like Bible menu, Commentary 
menu, Jumplists, some multimedia functions, Bible searching, some toolbars and others. This 
mode serves the needs of all users who wish to use Theophilos only as a general literature 
reader. Please note that this mode is only optional. The primary purpose of Theophilos is to 
help in your Bible study. You may find that in reader mode the program does not offer enough 
functionality, so use it only for special occasions. 
 
 
 
Saves current document 
 
 
Saves current document under different name 
 
 
Recording light - recording is in progress when flashing 
 
 
Mini Navigator is a toolbar equivalent of Navigator's Bible tab »Page 70 tool 
 
 
 

Creating new topic book 

Click on New book »Page 45 command in the Topics menu »Page 32. Dialog window will 
appear to let you fill in the name of your new topic book. Since this name is used also as the 
file name (extension “.tpb” is automaticaly added) it must be unique, e.g. only one topic book 
can have that name. If file of that name exists, Theophilos will ask you whether you want to 
overwrite that file. 
 
 

Opening topic book 

Under the Topics menu »Page 32 use the Open »Page 45 command to display the file open 
dialog. Choose topic book you wish to open. 
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Adding new topics to topic book 

Under the Topics menu »Page 32 use the Add topic »Page 45 command. This will add new 
topic. Enter the name of the topic as it should be displayed in the list of topics. Enter the text 
of topic in the topic content box. Save your new topic with Save »Page 45 command. See 
Add topic »Page 45 for more details. 
 
 

Renaming topics 

Topic names cannot be changed directly after they were saved. To change the name of the 
topic after it was saved use following procedure: 
Select all text in the topic window (Ctrl+A). Copy the selected text to the clipboard with the 
Copy command. Now add new topic and give it a new name. Paste the text previously copied 
to the clipboard with the Paste command. Save changes with the Save command. Go to the 
topic with the original name and delete it with the Delete item or Delete topic command. 
 
 

Deleting topics 

You can delete currently displayed topic with the Delete item »Page 67 or Delete topic »Page 
32 (pop-up menu) command. 
 
 

Creating new note set 

Simply click on New set »Page 46 command in the Notes menu »Page 32. Dialog window will 
appear to let you fill in the name of your new note set. Since this name is used also as the file 
name (extension “.nts” is automaticaly added) it must be unique, e.g. only one user note set 
can have that name. If file of that name exists, Theophilos will ask you whether you want to 
overwrite that file. 
 
 

Opening user note set 

Under the Notes menu »Page 32 use the Open »Page 46 command to display the file open 
dialog. Choose the note set you wish to open. 
 
 

Creating new jumplist 

Click on New list »Page 49 command in the Jumplist menu »Page 32. Dialog window will 
appear to let you fill in the name of your new jumplist. Since this name is used also as the file 
name (extension “.jpl” is automaticaly added) it must be unique, e.g. only one jumplist can 
have that name. If file of that name exists, Theophilos will ask you whether you want to 
overwrite that file. 
 
Tip: 
New jumplists may be created also by exporting Bible search results through Copier tool 
»Page 63 to jumplist or by merging »Page 50 several existing jumplists together. 
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Opening jumplist 

Under the Jumplist menu »Page 32 use the Open »Page 49 command to display the file open 
dialog. Choose the jumplist you wish to open. 
 
 

Adding new jumps to jumplist 

Under the Jumplist menu »Page 32 use the Add [verse name] »Page 51 command to add 
currently active verse to jumplist. To make particular verse active click on it in any opened 
Bible version window. Then click again on the desired jumplist and add the verse to it. 
 
 

Deleting jumps from jumplist 

You can delete currently selected jump with the Delete item »Page 67 or Delete jump »Page 
32 (pop-up menu) command. 
 
 

Sorting jumplists 

Jumplists can be sorted chronologically (by verse order), alphabetically (by description) or 
they can be unsorted. Especially the unsorted method can be useful if you wish to have the 
jumps in certain particular order (i.e. Bible events). In this mode each jump is added to the 
end of the list. Only in this mode you can move the jumps to a certain place. To do this press 
and hold ALT key and press the UP/DOWN arrows to move the jump to the desired place. 
 
To have the jumplist displayed in any of these sorting methods, select it in the Jumplist/Sort 
by menu. To quickly sort the jumplist chronologically or alphabetically click on the header 
section. 
 
The sorting method of each jumplist is saved when the jumplist is saved. Next time when you 
open the jumplist it will be sorted in the saved order of jumps. 
 
 

Recording sound 

Open any Bible version and click on verse you wish to record sound for. Use button with 
microphone symbol on the toolbar to start recording. Sound will be automaticaly attached to 
the active verse. To stop recording click the microphone button again or button with rectangle 
symbol. (Alternatively use the keyboard: press "F12" to start recording and again to stop.). If 
you noticed red LED light next to the microphone button was flashing while you were 
recording. This is to remind you of recording in progress.   
 
BE CAREFUL WHEN RECORDING OVER LONG PERIODS OF TIME! SOUND FILES CAN 
GROW VERY LARGE IN SIZE POSSIBLY CONSUMING MOST OF YOUR FREE 
HARDDISK SPACE! 
 
Note: 
You must have soundcard properly installed and configured in your computer and microphone 
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attached to soundcard and working. 
 
 

Sound playback 

To play sound attached to verse click on that verse (making it the active verse) and click on 
button with speaker symbol or use "Multimedia/Verse sound »Page 51" command. 
To play any sound file of supported type use "Multimedia/Open »Page 51" command to 
display Open dialog. 
 
See Tips and tricks »Page 99 topic for information on how to play Bible narration and other 
tips. 
 
 

Attaching multimedia files to verses 

To attach sound and picture to any verse click on that verse (making it the active verse) and 
use "Multimedia/Attach media to [verse name] »Page 52" command. 
 
 

Deleting attached multimedia files 

A simple way to delete attached sound in Theophilos is to record over it. If the new recording 
is shorter then half a second Theophilos will delete resulting sound file automaticaly next time 
you atempt to play it. More complicated way is to locate the sound file yourself and delete it 
as you would any other file. Pictures can be deleted this way only. Please read recording tips 
»Page 99 to learn how to locate attached files. 
 
 

Searching the Bible 

To search any loaded Bible version open the Finder under Find menu »Page 32. See Finder 
»Page 53 topic for further details. 
 
 

Searching any document 

Theophilos allows you to search any opened document including those that you have created 
(jumplist verse descriptions may be searched as well). Find/Search this document »Page 61 
command is used for this task. To switch searched document to another, activate its window 
and return back to this dialog. 
 
You may also search the entire library in one step using the Finder tool. Open the Finder 
dialog in the Find menu and switch to Library tab. You can now choose which documents to 
search by selecting the document type and check marking each individual document that you 
wish to include in your search. Clicking the Find button will execute the search. The results 
are then displayed in the Navigator's Results window. The documents that contain your 
search criteria will be displayed there as icons with names. When you double click on the 
document it will open with the first found search string highlighted. You can then press F3 to 
continue to search that document further for more matches until no more matches are found. 
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Searching dictionary topics 

In addition to Bible and document searches you may search dictionary and topic books topics. 
In any active window (jumplists are an exception) select some text you would like to find in 
dictionary topics (at least one must be opened). Theophilos will perform search in every 
opened dictionary or topic book. See Find/Find in dictionary topics »Page 60 command for 
more details. 
 
Tip: 
You can search all dictionaries by simply double clicking on the desired word in any open 
document. A special dictionary pop-up window will show where you can flip through all of your 
installed dictionaries to see if the topic on the selected word exists. 
 
Note: 
To search the contents of dictionary use Find/Search this document »Page 61 command 
instead. 
 
 

Getting to any verse quickly 

There are several ways to navigate the Bible in Theophilos. You can find further information 
under these topics: 
 
Browsing the Bible with the Navigator »Page 70 
Using the reference toolbar »Page 39 
Go to any book instantly through the pop-up menu »Page 40 
Quick bookmarks »Page 41 
Showing verse references and search results verses in context »Page 48 
Keyboard Shortcuts »Page 30 
 
Special navigation tool are Jumplists(TM). They are multifunctional lists of verse references 
that you can use as bookmarks for instant jumps to desired verses. Every such verse 
reference may have its own name or description to easily identify the verse.  
See Tips and tricks »Page 99 for examples how you may use them. 
 
 

Printing documents on the printer 

All outputs including printing are done through Copier »Page 63 tool under the Publish menu 
»Page 32. Use this tool to copy to clipboard, save to file or print all text including files you 
create. 
 
Note: 
For printing HTML documents and pictures a standard print dialog is used. 
 
 

Changing language in menus 

Theophilos can communicate in several languages. Select the language from the Language 
»Page 70 submenu in Program menu »Page 32.  
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Tip: 
Visit our Internet web site for new and updated language files. If your language is not included 
in the list, you may create a new localization of Theophilos in your language. If you need any 
assistance feel free to contact us for more details. 
 
Localizing Theophilos is easy to do. The language plug-in files have extension ".LDF" 
(language definition file) and can be found in the language folder. These files are in plain text 
format and are editable in a word processor. 
 
It is highly recommended that you use Windows Notepad for editing, since other word 
processors may change the file format or do unwanted character conversions. 
 
We will greatly appreciate if you send new localization plug-ins to us so we may offer them for 
free download to other users of Theophilos. 
 
In the same manner you can create or edit the verse reference recognition files (.RCG). 
These are simply text files with Bible book names or book abbreviations to teach Theophilos 
recognize Bible references in library texts correctly. 
 
Warning!  
Before you attempt to edit the language plug-in modules, be sure to create a copy of the file. 
Do not add or remove any lines in the LDF files. Doing so may produce unpredictable results. 
If you do not know how to translate any line or book name, LEAVE IT IN ENGLISH! Also do 
not change the order of books in .LDF or .RCG files! Some modules use a particular Bible 
book naming convention and Theophilos may not recognize the verse links correctly if edited. 
It is highly recommended to create a new RCG file for your personal usage. 
 
 

Changing fonts in windows 

Each window can have individual font settings. To change font in specific window only use the 
right mouse button to click on the window and display its pop-up menu. Use "Font settings... 
»Page 82" command to change font. Each type of window can have their default font »Page 
78 set. Default font is used every time a new window of specific type is opened. Change 
these settings if you use mostly fonts or character sets specific to your language. Default font 
settings are changed in Settings. 
 
Note: 
Some Bible versions need to have other than "western character set" setting to display 
correctly. If you change this setting in its window this character set will be used each time you 
open this version. 
 
Please note that to view some versions you must have Multilingual support installed in 
Windows(TM). 
 
Tip: 
You can change fonts even in Navigator »Page 70 tool. Font assigned to Navigator tool is 
used also in Range window »Page 58. 
 
See also Settings/Fonts »Page 73 
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Installing add-on modules 

Installing add-on modules is a trivial task. Below are the installation instructions for add-on 
modules depending on how you obtained the files: 
 
If you downloaded  the file from our Internet site »Page 98, follow the instructions given there. 
 
If you have ordered the Theophilos Library CD »Page 96 , all add-ons are automatically 
accessed by the program when the CD is in your CD-ROM drive (Data path »Page 80 must 
point to this drive). 
 
If you ordered Student  or Scholar  edition of the CD you must follow a routine for unlocking 
all locked add-ons »Page 81. You should have received any applicable unlock codes with 
your CD. If for any reason these codes are missing or you lost them contact us »Page 98 
immediately and we will send these codes to you. 
 
 
Theophilos Library CD »Page 96 may be ordered directly from us. Please see ordering 
information »Page 93 for more details. 
 
 
Please visit our Internet site »Page 98 frequently for new and updated versions of 
Theophilos software and add-ons as these are added immediately when they become 
available. 
 
 
 

Uninstalling Theophilos 

To uninstall the product use standard Windows uninstall procedure: in "Add/Remove 
Programs" dialog select Theophilos from the list of installed programs and click on 
"Add/Remove" button. Theophilos will remove itself and all associated files except files that 
were created or added by user manually (user notes, add-ons). These files can be deleted 
manually.  
 
Note: 
If you have not installed the program correctly or Theophilos is not included in the list of 
installed programs for any reason you may simply delete the folder in which Theophilos 
resides. Theophilos keeps all its configuration settings in its folder. No additional files are 
installed on your system. 
 
 

Playback of multimedia narrations from the CD 

On our Theophilos Library CD »Page 96 you will find many hours of narrated Bible passages. 
They are all listed in a jumplist called Greatest Bible Passages . To be able to enjoy hearing 
the Word of God follow these steps: 
 
1. Open King James version  of the Bible from the Bible menu. 
2. Under Jumplist menu, locate and click on Greatest Bible Passages  jumplist to open it. 
3. Double click on any of the listed passages. Bible text will move to selected place. 
4. Click on the Bible window. 
5. Press F10 key to show illustrations . Alternatively you can go to Multimedia menu and click 
on Verse picture command. 
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6. Press F11 key to start the playback . Alternatively you can go to Multimedia menu and click 
on Autoplay command. 
7. Sit back and enjoy. 
 
When the text of the passage is all read Theophilos will start scrolling the text automatically to 
next available narrated passage. To stop the playback and/or scrolling press F11 at any time. 
 
If you have Theophilos Audio Bible CD with Alexander Scourby's narration  you can play 
any verse in King James version since this text is narrated in its entirety. However, 
illustrations are available only for passages listed in Greatest Bible Passages jumplist. 
 
(Please note that you must have multimedia PC to be able to hear any sound.) 
 
 
 

HTML viewer 

Theophilos is the first Bible program in the world to offer its own built-in HTML viewer 
compatible with HTML version 3.2. This viewer is totally independent of any other Internet 
browser and there is no need to have any such browser installed on the computer. On the 
other hand Theophilos' HTML viewer is not a replacement of your favorite Internet browser. It 
will only show local files, e.g. those saved on your hard disk. However if you click on the link 
to Internet site within the document it will open your browser automatically and follow the link. 
While we cannot guarantee that all HTML documents downloaded from the Internet can be 
opened correctly most should work without any problem, however. 
 
We have designed a way to link HTML documents with all installed dictionaries and the verse 
references within the HTML text will take you directly to the right place in the Bible. HTML 
authors may in addition include special links »Page 90 in the HTML source to other library 
documents which will open automatically at specified place with a single click of the mouse. If 
you know how to write web pages, you are ready to go! 
 
You can integrate HTML documents into your library by moving them anywhere within the 
Theophilos' data search paths and renaming their extension to TML. Theophilos will add them 
to the library when the program restarts. 
 
Tip: 
Move only the index pages to the data path and edit the content of these files to point to 
HTML documents and graphics where they are located on your hard disk. You should rename 
the file to something that will best describe the content as the name of the document will 
display in the Library. For more information about HTML please refer to some HTML 
language manual. 
 
See also Special links recognized by Theophilos »Page 90 
 
 
 

Special HTML tags 

HTML viewer in Theophilos is compatible with HTML 3.2 but offers a way to link your HTML 
files with the rest of the library. For example you can open Easton's Bible Dictionary by 
clicking on a link in HTML document.  
 
Here are some examples of such links: 
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<A HREF="THEO:Easton's Bible Dictionary=love"> Click here </A> 
 
This example shows how to create a link from the HTML document to any of the Theophilos 
library documents. The document will open at the specified place, in this case the "love" topic. 
Please note that if the HTML document with special Theophilos document link is displayed in 
external browser the link will not work obviously. The document you link to must be installed 
in the user's library or a "not found" message will appear. You must use the exact name and 
punctuation in the title of the document and the document's topic. The value for the document 
parameter can be the name of any existing topic in that document. You can link to 
dictionaries, commentaries, writings or TML files. If linking to TML file you must enter "none" 
as the topic, as there are no topics defined in the HTML documents. 
 
<A HREF="THEO:BIBLE=lk 1:3"> Click here </A>  or 
<A HREF="THEO:BIBLE=42,1,3"> Click here </A> 
 
This will create a link from the HTML document to a Bible verse. The valid values can be 
either the name of the verse as used by Theophilos or book number, chapter and verse. The 
numbers must be separated by a comma. 
 
<A HREF="THEO:FILE=myjumplist.jpl"> Click here </A> 
 
This will create a link from the HTML document to "myjumplist.jpl" file. This file should be 
placed within the Data path or program path. You must provide any additional subdirectory 
path if necessary but since all paths are relative to Data path or program path you should not 
include the full path to the file. 
  
 
 

How to distribute the modules 

Distribution of your own modules is up to you and you may choose any preferred way. 
Probably the most effective is distribution over Internet but you may choose to offer your 
modules on diskettes or CDs as well. If you wish to distribute your modules with Theophilos 
application on a CD, you are required to obtain a special license from us. For more 
information please read the topic about Publishing and distributing your own CD products 
»Page 28. 
 
Module authors may include with the module an information file which can contain anything 
the author wishes to inform the reader about concerning a particular module. The file must 
have the same file name as the module (text before the file extension) and can be of the 
types: TXT (plain text), DOC (plain text or MS Word), RTF (Rich Text Format) or WRI (MS 
WordPad). The user can display the information by right clicking on the window and selecting 
"Module information". 
 
In addition you may include with your file also a short copyright notice (less then 500 bytes 
recommended). To do so create a short text file (preferably in MS Notepad) and give it the 
name of the module file with the .CPR extension. This copyright notice will display only once 
during the Theophilos session when the module is first opened. 
 
Authors of Theophilos content have the option to include along with their work a special menu 
installation file (MIF) with the information where the module should be placed in the user's 
library. If the submenu does not exist it will be created. The distributed MIF file must be 
copied to Theophilos' program folder prior to program start and will then be automatically 
deleted from the user's system. 
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To have a module(s) installed in an appropriate place, create a text file and give it a .MIF 
extension. The file should contain information in the following format: 
 
#[main_menu] 
(can be bible, dictionary, commentary, writing, html or multimedia)  
 
%0[name_of_the_first_level_submenu]  
(if it does not exist it will be created)  
 
&0[title_of_the_first_module]   
(spelling and punctuation must match the document title)  
 
&0[title_of_the_second_module]   
(you may add several modules to the same menu)  
 
%1[name_of_the_second_level_submenu]   
(up to ten levels can be created numbered from 0 to 9)  
 
&1[title_of_the_module]   
(this will be added to the second level submenu)  
 
You may add modules of different types in one MIF file or provide a separate MIF for each 
module. 
 
Example:  
 
#dictionary 
&0Ivan Jurik 
%0Ivan's dictionary of programming tips 
#writing 
&0Classics 
&1Shakespeare 
%1Hamlet  
 
The above will instruct Theophilos to create "Ivan Jurik" submenu under Dictionary menu and 
place "Ivan's dictionary of programming tips" there. In addition "Classics" submenu will be 
created under Writings menu (if it does not already exist) with yet another second level 
submenu called "Shakespeare". Here the "Hamlet" module will be placed. The MIF file is then 
deleted automatically. 
 
Note: 
The MIF file is optional and does not have to be provided. Only when the author of the 
module wishes to install his work in a special place in the user's library is such a file 
necessary. If not provided the module will be installed at the top level of a particular main 
menu. 
 
 
 

Order form 

We appreciate your interest in Theophilos software. By your order you are directly supporting 
all further developments of Theophilos and related products. Please print, fill out and mail this 
form together with payment to us »Page 98. 
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Purchase order: 
 

Order item(s): 

Item name or description                   No. pieces       Price 

THEOPHILOS LIBRARY CD BASIC     $39.00   
(upgrade and additional copies $29.00)______________________$______ 

THEOPHILOS LIBRARY CD STUDENT  $59.00   
(upgrade and additional copies $49.00)______________________$______ 

THEOPHILOS LIBRARY CD SCHOLAR  $79.00   
(upgrade and additional copies $69.00)______________________$______ 

 
SHIPPING AND HANDLING CHARGES   $4.00   
(additional copies $2.00 each)______________________________$______   

 
TOTAL AMOUNT DUE 
(if sending check  or money order  add $5.00  handling fee)    $______  
 

Your mailing address: 

Your name:           ______________________________________ 

Address:             ______________________________________ 

City:                ______________________________________ 

ZIP Code:            _________  

State/Country:       ______________________________________ 

Phone/FAX:           ______________________________________ 

e-mail address:      ______________________________________ 

 

Form of payment: (  ) Cash  (  ) Check  (  ) Money order 

                 (  ) Bank transfer  (  ) Other ___________ 

 

Date:__________________ Signature:________________________ 

Thank you for your order! 

 
 

Ordering information 

We strongly recommend to visit our Internet site »Page 98 for free downloads  and possible 
discounts . On our website you will find all up-to-date information about all available products, 
updates, current prices and ordering. 
 
 
ORDERING THEOPHILOS LIBRARY CD USING YOUR CREDIT CARD 
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CLICK HERE IF YOU WISH TO USE YOUR CREDIT CARD »Page 95  
 
 
ORDERING THEOPHILOS LIBRARY CD BY OTHER MEANS  
 
Disregard the below information if you are ordering using your credit card. This is how you 
can order your CD without credit card :  
 
1. Print the order form »Page 92 . If you do not have printer and you are unable to print 
the order form out, use it as an example and on a separate sheet of paper try to put as much 
information down as possible.  
 
2. Fill the order form  including number of CD copies and total amount (in US dollars). 
Please add $5.00  to the total if you wish to send check  or money order . Our bank requires 
this amount for handling charges. Please make sure that the order is readable to prevent any 
misunderstandings. Do not forget to include your correct mailing address!   
 
3. Choose one of the appropriate forms of payment below . In addition to credit cards you 
may pay by checks , international money orders  and direct transfers  to our bank account.  
 
4. Mail the order  form along with the correct sum to our address »Page 98 . 
 
Make checks  and money orders  payable to: Ivan Jurik 
 Datelinova 1 
 821 01 Bratislava 
 SLOVAKIA 
 
Transfers  to our Slovak bank account: 
Bank: VSEOBECNA UVEROVA BANKA a.s., Bratislava, SLOVAKIA 
Account number: 1192338659 
Swift code: SUBA SK BX 
 
Choose one of the following forms of payment depending on your residence: 
 
1. From Europe : 

You should fill the order form »Page 92  out in US$ and afterwards convert the total amount 
to your local currency or Slovak Crowns with the current exchange rate. 

• Transfer to our Slovak bank account. Do not forget to also send in the order form! 
• Eurocheque  in Slovak Crowns (SK) 
• International money order  in your currency, add equivalent of US $5.00 to the total 

amount for bank handling fees. 
• Cash (AT YOUR OWN RISK) - your currency, bank notes only, current exchange rate 
 
2. From USA (US dollars): 

• Transfer to our Slovak bank account. Do not forget to also send in the order form! 
• Personal check  or cashier's check  drawn on a US bank, add $5.00  to the total amount 

for bank handling fees. 
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• International money order , add $5.00  to the total amount for bank handling fees. 
• Cash (AT YOUR OWN RISK)  - US bank notes only 
 
3. From Canada and Australia : 

You should fill the order form »Page 92 out in US$ and afterwards convert the total amount to 
your local currency with the current exchange rate. 

• Transfer  to our Slovak bank account. Do not forget to also send in the order form! 
• Check  or International money order  in CAN$/AUS$ (drawn on a Canadian or Australian 

bank), add equivalent of US $5.00 to the total amount for bank handling fees. 
• Cash  (AT YOUR OWN RISK)  - in CAN$/AUS$, bank notes only, current exchange rate 
 
4. From the rest of the world  (US dollars only): 

• Transfer  to our Slovak bank account. Do not forget to also send in the order form! 
• International money order , add $5.00  to the total amount for bank handling fees. 
• Cash  (AT YOUR OWN RISK)  - US bank notes only 
 
Please allow reasonable portion of time for mail delivery which usually does not 
exceed 14 days one way. Orders are shipped immediately upon receipt of your 
payment.  
 
AUTHOR RESERVES THE RIGHT TO CHANGE ANY INFORMATION INCLUDING PRICES AND AVAILABILITY 
OF ITEMS MENTIONED ON THIS PAGE AT ANY TIME AND WITHOUT PRIOR NOTICE.  
 
 

Credit card ordering 

 

    
 
You can order your Theophilos Library CD with American Express , Discover , Master Card  
or Visa  from DigiBuy in the following ways: 
 
When you order you must specify which edition »Page 96 of the CD you want. Below is a 
price list (in US dollars) of Theophilos Library CD editions: 
 
BASIC   - $39.00 
STUDENT - $59.00 
SCHOLAR - $79.00 
 
There is additional $4.00 shipping and handling fee. We offer $10.00 discount for upgrades 
from previous versions and for additional copies. 
 
Ordering by phone 
DigiBuy operators are available from 8:30 a.m. to 5:30 p.m. CST Monday-Friday at: 
800-242-4775 Extension: 15663  or at 713-524-6394 Extension: 15663   
Have your credit card ready! 
 
THE ABOVE PHONE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY. THE 
AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS. 
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Any questions about the status of the shipment of the order, refunds, registration 
options, product details, technical support, volume discounts, dealer pricing, site 
licenses, non-credit card orders, etc., must be directed to our address. »Page 98 
 
Ordering ONLINE through Internet 
Theophilos order link: 
http://www.the ophilos.sk/ccard.htm 
When you access this site you will be able to choose other forms of ordering like fax, mail or 
phone. We offer secure transactions to protect your personal data. 
 
To insure that you get the latest version, DigiBuy will notify us within one business day of your 
order and we will ship the CD directly to you. Please allow reasonable portion of time for 
mail delivery which usually does not exceed 14 days. 
 
AUTHOR RESERVES THE RIGHT TO CHANGE ANY INFORMATION INCLUDING PRICES AND AVAILABILITY 
OF ITEMS MENTIONED ON THIS PAGE AT ANY TIME AND WITHOUT PRIOR NOTICE.  
 
 

Theophilos Library CD 

 
If you like our program and you appreciate the freeware package, but want to have more 
study materials , illustrated narrations , maps  and music  you may want to order our 
Theophilos Library CD. This CD comes really packed  with many exciting materials for your 
study and enjoyment. Depending on what you need we offer three editions of the CD: Basic , 
Student  and Scholar . 
 
Please read more about the contents of these editions here. »Page 96  
 
If you would like to order your CD now you may do so using your credit card, check or money 
order. For more details go to the ORDERING INFORMATION »Page 93  section. 
 
 

Theophilos Library CD Content 

 
Since the latest Theophilos Library CD releases may contain additional add-ons which were 
not available at the time of release of this help file, we strongly recommend to visit our 
Internet pages »Page 98 for more accurate information. 
 
 
The contents of the Basic edition : 
 
- Theophilos Bible Software version 3.0 
- Greatest Bible passages narrated by Stephen Jones 
- 213 illustrations by Gustav Doré 
- High quality maps 
- Music by Kerry Livgren in CD quality (10 songs) 
- Scribe for Theophilos 2.0 (evaluation version) 
- Split it! file splitting utility 
- Free package that you can give to your friends 
 
English Bibles: 
American Standard Version 
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Apocrypha 
Bible in Basic English 
Darby's Version 
King James Version 
King James Version with Strong's Numbers (locked) 
New American Standard Bible (locked) 
New American Standard Update (locked) 
Webster Bible 1833 
Weymouth New Testament 
Young's Literal Translation 
 
Foreign Bibles: 
Cesky ekumenicky preklad (czech) 
Dutch Statenvertaling 1637 
Finnish Pyha Raamattu 1938 
Karoli Biblia (hungarian) 
Kralicka bible (czech) 
La Nuova Diodati (italian) 
Louis Segond 1910 (french) 
Luther Bibel 1912 (german) 
Nova Bible Kralicka - Novy zakon (czech) 
Nova smlouva (KMS) (czech) 
Reina Valera 1909 (spanish) 
Rohackov preklad (slovak) (locked) 
Russian Synodal Bible 
Stephanus Textus Receptus 
Versiunea Dumitru Cornilescu (romanian) 
 
Dictionaries: 
Condensed Biblical Cyclopedia 
Easton's Bible Dictionary 
Harriet N. Cook: Scripture Alphabet of Animals 
Hitchcock's Bible Names Dictionary 
Nave's Topical Bible 
Strong's Greek and Hebrew-Aramaic Dictionary (locked) 
Thompson's Chain Topics 
Torrey's Topical Textbook 
 
Commentaries: 
Geneva Bible Notes 
Jamieson, Faussett, Brown Commentary 
King James Translators' Notes 
Matthew Henry's Commentary 
St. John Chrysostom: Homilies on Matthew 
Treasury of Scripture Knowledge 
Weymouth: Introductions to NT Books 
 
Writings: 
A Gospel Tract 
A. W. Pink: The Antichrist 
B. Pascal: Pensées 
C. H. Spurgeon: Daily Readings 
Creeds of Christian Faith 
Daily Bible Reading 
D. Baron: The Servant of Jehovah 
Graetz: History of the Jews 
J. Calvin: Biblical Commentaries 
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Josephus: Against Apion 
Josephus: Antiquities of the Jews 
Josephus: Miscellaneous 
Josephus: The Wars of the Jews 
S. Asch: One Destiny 
S. H. Kellogg: Atonement in the Old Testament 
Sinners in the Hands of an Angry God 
St. Athanasius: On the Incarnation 
St. Augustine: Confessions 
St. Augustine: Handbook on Faith, Hope and Love 
St. Augustine: On Christian Doctrine 
St. Augustine: The City of God 
St. Thomas Aquinas: Summa Theologica 
Teaching of the Twelve Apostles 
The Pilgrim's Progress 
The Preacher's Library 
Thomas Kempis: Imitation of Christ 
 
The contents of the Student edition : 
 
All files from the Basic edition plus: 
- New American Standard Bible unlock 
- New American Standard Update unlock 
- King James Version 2000 with Strong's Numbers unlock 
- Strong's Greek and Hebrew-Aramaic Dictionary unlock 
 
The contents of the Scholar edition : 
 
All files from the Basic edition plus: 
- New American Standard Bible unlock 
- New American Standard Update unlock 
- King James Version 2000 with Strong's Numbers unlock 
- Strong's Greek and Hebrew-Aramaic Dictionary unlock 
- Single user registration for Scribe for Theophilos authoring 
software 
 
If you would like to order your CD now you may do so using your credit card, check or money 
order. For more details go to the ORDERING INFORMATION »Page 93  section. 
 
 

Contacting us 

 
Theophilos Bible Software is currently distributed by its author. 
Please mail all your orders and other correspondence to the address below: 
 
Ivan Jurik 
Datelinova 1 
821 01 Bratislava 
SLOVAKIA 
 
or send e-mail to: 
vana@theophilos.sk 
for all your information needs. 
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We strongly recommend to visit our web site where you can find the latest information, 
updates, many useful links and downloadable files: 
http://www.the ophilos.sk 
 
 
 

Tips and tricks 

GENERAL 
 
Read the Quick Guide To Theophilos 3.0  
A Quick Guide To Theophilos 3.0 is a must read for every new user but we recommend even 
to the long time users of Theophilos to read this document and see what's new in this latest 
release. You can find it under the Writings menu. Highly recommended!  
 
Use right mouse button extensively throughout the program.  
Every window in Theophilos has its own pop-up menu . Many commands and options are 
accessible through these menus to help you use the program more effectively. See Menus 
and commands »Page 32 topic. 
 
Use the Navigator to open library documents, navigate the Bible or review the library 
search results.  
 
Use the Library manager to manage the constantly growing library of available add-
ons.  
Don't let the great number of downloadable add-ons for Theophilos overwhelm you! You can 
stay in the driver's seat, create submenus in your library and move documents around in them 
according to your preference. If you are an author and distribute your own add-on modules 
you can control where your work will be installed in the user's library. Just include a special 
menu definition file with your modules and you can create submenus on the user's system 
and place your modules there. For more information see How to distribute your add-ons 
»Page 91 topic. 
 
Reusable windows - a new way of your desktop management.  
While you can open as many windows in Theophilos as will fit on your screen, you will soon 
find that a cluttered desktop with many open windows will make your study difficult. Now you 
can reuse any open window and replace its content with any other document simply by 
dragging its icon from the Navigator to the text area of the window. Since every window keeps 
its own document and window history you can always go back to the previous document and 
switch between them. You can open any number of documents in any window. You can also 
mark any window as reusable so every time you open new document from the menu it will 
show in the reusable window. See Reusable windows »Page 39 for more information. 
 
Document and window history.  
Each window and document keeps its history to let you go back to any place in the document 
or any document which was previously shown in the window. See Document history »Page 
69 and Window history »Page 69 for more details. 
 
Browse HTML pages in Theophilos.  
Theophilos features its own HTML viewer for viewing HTML content without the need of 
external browser. If you now how to create HTML pages you can create HTML pages with 
special links to the rest of Theophilos library documents accessible from your HTML 
documents! Read more about HTML and Theophilos »Page 90 
 
Build your own library of add-ons for your own pleasure or commercial distribution.  
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Whether you are an individual user, a publishing house or large Christian organization and 
you have texts that you would like to work with in Theophilos, e.g. your studies, custom 
dictionaries or commentaries, you can make Theophilos compatible add-ons from them. You 
can plug them in as you do any other add-on so that you can share them over your local 
network with other users or distribute them as you wish. For those that want to have freedom 
in creating their own add-on modules for Theophilos or wish to electronically publish their 
works for thousands of Theophilos users we provide a full featured authoring tool called 
Scribe for Theophilos »Page 13. You can download an evaluation version from our Internet 
site »Page 98 for free.  
 
If you wish to distribute your own CD products with Theophilos be sure to read the following 
topics: Theophilos advantage »Page 27, Publishing and distributing your own CD products 
»Page 28, Distribution of Theophilos »Page 29 
 
Theophilos operates in two interface modes.  
Depending on the content of your library (or CD content) Theophilos will use an appropriate 
mode to interact with the user. It will act either as a full featured Bible study application or a 
general literature reader. This allows publishers and users to use one application for many 
different purposes. 
 
Color your Bible.  
You can mark special Bible passages with different colors for easier navigation. With 
Theophilos we distribute KJV Bible with Christ's words in red. You can even exchange the 
coloring schemes with other users! For more information see Bible coloring »Page 41 topic. 
 
Double click on any word in any document to display the dictionary or commentary 
pop-up.  
You can lookup any word in the dictionary if you double click on any word throughout the 
library. If you double click on a verse reference in the Bible windows you can view all 
commentaries on that verse instantly! 
 
Organize the modules on your hard disk.  
Theophilos now uses in addition to main Data path and the program folder also other search 
paths as defined by the user. This will allow you to organize data files on your disk into 
individual subfolders. The paths will be searched in the following order: Theophilos program 
folder, main data path (usually a CD drive) and user specified folders. If more than one 
document of the same type is found with the same title only the first one will be added to the 
library. Duplicate library titles of the same type are not allowed. Files in the new data format 
(.T30) have priority over the old format (.DAT). 
 
Listen and watch the preview of Bible narration in the free package.  
We have added to the free copy of Theophilos a preview of Bible narration  that you can 
listen to if you own a multimedia PC (with soundcard and speakers). This is only a demo of 
what is available on Theophilos Library CD »Page 96. In addition you must have audio 
compression support installed from MS Windows™ installation CD. If your computer complies 
with these requirements you are ready to listen to the demo: 
 
1. Open King James version  of the Bible from the Bible menu. 
2. Go to Genesis 1:1 
3. Press F10 key to show illustrations . Alternatively you can go to Multimedia menu and click 
on Verse picture command. 
4. Press F11 key to start the playback . Alternatively you can go to Multimedia menu and click 
on Autoplay command. 
5. Sit back and enjoy. 
 
The passage included with the free package starts at Genesis 1:1 and ends with Genesis 2:3. 
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When the text of the passage is all read Theophilos will start scrolling the text automatically in 
attempt to find next available narrated passage. Since there are no other narrated passages 
available in the free package you should stop the search by pressing F11 at any time. If you 
liked what you heard and saw maybe you would like to order Theophilos Library CD »Page 96 
with many hours of narrated passages. 
 
How to play multimedia narrations from the CD.  
On our Theophilos Library CD »Page 96 you will find many hours of narrated Bible passages. 
They are all listed in a jumplist called Greatest Bible Passages . To be able to enjoy hearing 
the Word of God follow these steps: 
 
1. Open King James version  of the Bible from the Bible menu. 
2. Under Jumplist menu, locate and click on Greatest Bible Passages  jumplist to open it. 
3. Double click on any of the listed passages. Bible text will move to selected place. 
4. Click on the Bible window. 
5. Press F10 key to show illustrations . Alternatively you can go to Multimedia menu and click 
on Verse picture command. 
6. Press F11 key to start the playback . Alternatively you can go to Multimedia menu and click 
on Autoplay command. 
7. Sit back and enjoy. 
 
When the text of the passage is all read Theophilos will start scrolling the text automatically to 
next available narrated passage. To stop the playback and/or scrolling press F11 at any time. 
 
If you have Theophilos Audio Bible CD with Alexander Scourby's narration  you can play 
any verse in King James version since this text is narrated in its entirety. However, 
illustrations are available only for passages listed in Greatest Bible Passages jumplist. 
 
(Please note that you must have multimedia PC to be able to hear any sound.) 
 
CD version is more space efficient   
CD version is recommended for systems with smaller disk capacity because it requires only 
approximately 4 MB of harddisk space for installation. You can save space by loading only 
those Bible versions you need for immediate study. 
 
Theophilos can run in network environments  
Since you may share data files (Bible versions, dictionaries, commentaries and other add-
ons) over your existing network is Theophilos an ideal Bible software to use in large study 
groups (e.g. seminaries, universities). See more information on how to configure Theophilos 
for use in your network »Page 20. 
 
Synchronization of Bible texts has two modes.  
By default Smart synchronization is used. See Bible/Synchronized »Page 41 and 
Settings/Bible section »Page 73 topics for more details. 
 
Font settings may be set separately for each window.  
These individual settings are temporary and will be lost when window is closed. To make 
them permanent use default font settings instead. See Default font settings »Page 78 and 
Font settings »Page 82 topics for more details. We highly recommend to use Microsoft's 
Verdana TrueType font created specifically to address the challenges of on-screen display. If 
you don't have it already installed, free download is available from: 
http://www.microsoft.com/truetype/fontpack/win.htm Here you can download Verdana for 
Windows 95 & Windows NT [verdan32.exe: 321KB, self installing file] – which contains 
extended set of characters – necessary if you plan to use Theophilos Bible translations in 
Central and Eastern European languages and have Win95/NT multilingual support installed. 
 



Theophil.RTF Theophilos help Page 102 of 109  

Search all documents with simple search dialog.  
Every document even your notes, topic books or Jumplists™ may be searched for text. Use 
"Find/Search this document »Page 61" command to search document in active window. Bible 
texts are searched using Finder »Page 53 tool with advanced search options. 
 
You can search your entire library in one step.  
Open the Finder dialog (Ctrl+F) and switch to Library tab. Here you can choose which 
documents you wish to search and set the conditions for your search. For more information 
see Searching any document »Page 86 
 
If you invoke Finder or document search dialog with some text selected in active 
window, it will become the search string.  
 
Add verse references to your documents for later reference and instant jumps to verse 
context.  
See Context of [verse name] »Page 48 topic for more details. 
 
Jump to Bible verses instantly with "Context of" feature.  
With cursor over verse reference (e.g. Jn 3:16) in dictionary, commentary, writing or your own 
document use "Find/Context of [verse name] »Page 48" command. 
 
Use Copier for all outputs from Theophilos.  
Content of any active window may be copied to Windows clipboard, saved to text file or 
printed on your printer. You may even print entire Bible or dictionary. With desired window 
being active invoke Copier and set your output preferences. See Copier »Page 63 topic for 
more details. 
 
Use Copier to export Bible search results to Jumplist.  
With Search results window active invoke Copier »Page 63 and select "Jumplist" as target. 
You will be asked for name of jumplist file. If this does not exist it will be created. If jumplist 
already exists, new verses will be appended to it. We recommend to keep reasonable number 
of verses in jumplists as they may become hard to navigate and thus loose their intended 
purpose. 
 
Add your documents to menus for instant access.  
To have your documents (notes, topic books, jumplists) easily accessible with a single mouse 
click you may add them to menu. Simply change the last letter in the document file's 
extension to "m" and it will appear in the menu. For this to work the file must be in Theophilos' 
program folder or in "User files path »Page 80". If you do not wish to see such file in menu 
anymore, change its file name extension to original. 
Extensions of user files recognized by Theophilos: topic books - *.tpb, *.tpm (these are shown 
in menu), note sets - *.nts, *.ntm (these are shown in menu), jumplists - *.jpl, *.jpm (these are 
shown in menu), HTML documents - *.htm or html, *.tml (these are shown in menu). HTML  
documents (with TML extension) must reside anywhere within the searched paths and the 
program adds them to the menu upon restart. 
 
Contact manager in Theophilos? Yes, you can use Topic books even as database of 
your contacts, addresses and phone numbers if you wish.  
 
"Delete item" command works differently in each window.  
Depending on what type of window is currently active you may delete topics from topic books, 
jumps from jumplists or delete entire verse from Bible search results window. 
 
Save your desktop settings to open windows automaticaly on startup.  
Program restores desktop setup with all windows settings (position, size, content, individual 
font settings). You can save as many setups as you wish and name them yourself. This can 
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be helpful when more than one user uses the same copy of Theophilos on one computer. For 
more information see Save window setup »Page 75 topic. 
 
Help us to create localization of Theophilos in your local language or create one 
yourself easily.  
Your existing copy of Theophilos may speak your own language . All you have to do is 
translate few words and sentences from English to your language. For more information on 
how to do this see Localization of Theophilos »Page 87 
 
Enhance your study experience with many available add-ons.  
You may download many free add-ons from our pages or other sites on Internet or order 
Theophilos Library CD »Page 96 with Bible versions, dictionaries, commentaries, writings, 
maps, Bible narrations and much more. 
 
Copy data files to your hard disk so you don't have to use CD at all.  
If you wish to eliminate use of CD for some reason you may copy some or all data files to 
your computer harddisk. After normal successful installation process copy selected data files 
(*.t30 and *.dat) to Theophilos program folder. We do not recommend this since data files can 
consume very large amount of free space on your hard disk. This operation is recommended 
only for advanced users. Please read also Warranty and License Agreement »Page 15. 
 
Use your mouse wheel in document windows.  
If you have MS Windows 98  or higher installed you can enjoy a built-in support for mice with 
wheels in Theophilos. 
 
 
JUMPLISTS™ 
 
Try our sample jumplists.  
We have provided several sample jumplists to show you how they can be used. There are 
some available directly under the "Jumplist »Page 32" menu for ease of access. This is to 
show you that you can put files to menus or remove them at your will. See tips in the 
beginning of this section to learn how to perform this task. Please note that there are many 
jumplists not shown in the menu and you can access them by the "Jumplist/Open... »Page 49
" command in Theophilos' folder. You may rename, modify or add to these jumplists your own 
jumps freely. Please check our web site »Page 98 for more jumplists. 
 
Use Jumplists™ for instant access to verses and playback of multimedia files attached 
to them.  
You may view jumplists as multifunctional bookmarks. Double click on jumplist entry will get 
you instatly to corresponding place in the Bible. If you have "Verse sound »Page 51" and 
"Verse picture »Page 52" features turned on multimedia files attached to such verse will be 
played as well. If you combine this feature with data projector you will add power to your 
presentation and your audience will stay awake as music or audio recording is played and 
pictures are shown. Your study group will not be the same again! 
 
Create special topical jumplists.  
Whatever topic you are studying jumplists will help you keep all relevant verses easily 
accessible from one window. We recommend to create separate jumplists for each group of 
related verses as this will help you keep your study organized. 
 
Name every verse reference with custom text.  
To improve your navigation even more you may give every entry in your jumplist an individual 
name or description. Theophilos by default uses first few letters from the verse to create 
automatic descriptions, but you have the choice to edit them to display your own text. 
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Sort your jumplist entries.  
You may sort each jumplist either chronologicaly (default) or alphabeticaly by description. 
Click on the column header to choose desired sorting method instantly. Or have the jumplist 
show in unsorted order. In this mode you can move the individual jumps by holding the ALT 
key and pressing the UP and DOWN arrow keys. 
 
Copy, save or print complete verse texts from Jumplists™ through Copier using Bible 
version of your choice.  
You may print your jumplists in more than one way. You have the choice to print entire 
jumplist with descriptions as displayed in jumplist window or print complete text of verses. You 
decide which Bible version to use in Copier dialog »Page 63. If you wish to copy only single 
verse use Copy verse »Page 66 command. Jumplist will use text from currently active version 
(last selected). Copy »Page 65 command will copy selected jumplist entry to let you paste it in 
another opened jumplist window. 
 
Adjust verse column width in Jumplists™ to exact value.  
Verse column width may be adjusted visually from Settings/Other documents »Page 73 
dialog. Using the arrows beside the edit box, columns of all open jumplists are adjusted 
simultaneously. All jumplists will use this value as they are opened. 
 
 
MULTIMEDIA 
 
Play your favourite tunes.  
Theophilos supports sound files also in MPEG layer 3 format (*.mp3) for playback besides 
Wave (*.wav) files. As this format becomes popular for its supreme compression ratios 
without decreased playback quality many files are available on the Internet with many popular 
music titles. You may open and play these files directly from Theophilos or attach them to 
verses. 
 
Add your pictures and sounds to Multimedia menu for instant access.  
You may add your own custom pictures and sounds to this menu very easily. Simply copy 
such files to respective folders ("\sound" or "\picture" - create them in Theophilos program 
folder if they do not already exist). Next time the program starts they will be added to this 
menu. You can even add motion video files in AVI and MPG formats. We recommend this 
feature to add your own maps or charts. 
 
Attach your sound and picture files to every verse in the Bible.  
Every verse in the Bible may have one sound and one picture file attached. These are played 
automatically when "Verse sound »Page 51" and "Verse picture »Page 52" toggles are on 
and such verse becomes the top verse. Currently only Windows Bitmap (BMP) and JPEG 
(JPG) formats are supported for pictures. See Multimedia/Attach media »Page 52 topic for 
more information. 
 
Record your own Bible narration in your own voice and language without leaving 
Theophilos or use third party recording software.  
If you have soundcard properly installed and configured in your computer and you have also 
microphone attached you may create Bible narration in your own voice or simply use this 
feature for personal audio notes to every verse in the Bible. Open any Bible version and click 
on verse you wish to record sound for. Use button with microphone symbol on the toolbar to 
start recording. Sound will be automatically attached to the active verse. To stop recording 
click the microphone button again or button with rectangle symbol. (Alternatively use the 
keyboard: press "F12" to start recording and again to stop.). If you noticed red LED light next 
to the microphone button was flashing while you were recording. This is to remind you of 
recording in progress.   
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BE CAREFUL WHEN RECORDING OVER LONG PERIODS OF TIME! SOUND FILES CAN 
GROW VERY LARGE IN SIZE POSSIBLY CONSUMING MOST OF YOUR FREE 
HARDDISK SPACE!  
 
You may use also third party software of your choice to do your recording but you should be 
aware of supported file formats and naming scheme of files in Theophilos. Theophilos uses 
following structure for locating attached files. Sound files are located in subfolder named 
"\sound" in Theophilos program folder. Next Bible books folders are following with book 
numbers padded with zero as their name (two digits). Similarly chapter subfolders use their 
numbers as name and are also padded with zeros (must be three digit number). Files 
themselves are on the verse level with same naming scheme (three digits with zeros).  
Example: sound for John 3:16 will be located in "\sound\43\003\016.wav". Good news is that 
you do not have to go through such difficulties but simply name your files as you wish and 
then attach them to verses from Theophilos interface. Theophilos will create a copy of your 
file and will correctly rename it and place it to the correct folder. Picture files are located in 
subfolder named "\picture" and use identical naming convention. (Advanced users) 
 
Listen to the Bible while you work with your favourite applications.  
If you have Theophilos Library CD »Page 96 or Theophilos Audio Bible CD with Bible 
narrations or have recorded your own you can now listen to it in the background. Simply click 
the Autoplay »Page 52 command while in Bible window and minimize Theophilos application. 
You can now do your work while listening to the Word of God. 
 
Create and run impressive multimedia presentations of God's Word to attract children 
and adult audiences.  
Reading some of the above tips you probably already have the idea of what multimedia is 
about. You can now put it to work in your home or church to make your teaching more 
compelling then ever.  
 
Use several versions of your own audio notes or narrations.  
Theophilos locates sound files in subfolder named "\sound". To create second set of sound 
attachments rename this folder. When you wish to use the first set again rename the folder 
back to "\sound" again. 
 
Change the opening music theme.  
Theophilos plays file "intro.wav" by default when the "Play sound on startup »Page 78" is 
checked. This file can be found in "\sound" directory. If you rename other sound file to this 
name and copy to this directory, program will play this file next time it starts. Alternatively if 
you are an advanced user you may change the name of the file to be played in the 
"theophil.ini" file. 
 
Conserve harddisk space with optimal quality/size recording setting.  
BE AWARE that sound files may grow significantly in size possibly consuming most of your 
free harddisk space. Therefore consider a compromise between sound quality and efficiency 
in your recordings. You may adjust this setting in Settings/Multimedia »Page 73 dialog. 
 
Conserve harddisk space with third party sound compression software.  
Sound files can take up significant amounts of space on your hardisk. Theophilos has built-in 
support for playback of MPEG layer 3 compressed sound files. You must install Audio 
compression support from MS Windows™ installation CD if you wish to use compressed 
Wave (MS ADPCM) files for playback. We recommend compressing your recordings with 
third party compression software to help reduce free space consumption. For advanced users 
only. 
 
Delete unwanted sounds and pictures.  
A simple way to delete attached sound in Theophilos is to record over it. If the new recording 
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is shorter then half a second Theophilos will delete resulting sound file automaticaly next time 
you atempt to play it. More complicated way is to locate the sound file yourself and delete it 
as you would any other file. Pictures can be deleted this way only. Please read recording tips 
to learn how to locate attached files. 
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